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LICENSE NOTICE, LIMITED
WARRANTY AND DISCLAIMER
AND LIMITATION OF LIABILITY
Abracadata, Ltd. grants to Licensee the non-exclusive
license to use the Software on one computer and to make
a backup copy of the Software for Licensee’s own use.
The “Licensee” is the single individual or business entity
for whom the Software was originally purchased. All
rights and protections under federal, state and
international law, including but not limited to the law of
copyright, patent, trademark, trade secret and contract,
shall remain in full force and effect. Licensee may not
download, reproduce, distribute, republish, sell, rent,
lease, sublicense, or translate the Software or
documentation in violation of those laws and this
License. The Software remains confidential, proprietary
information, in which Abracadata, Ltd., the authors,
suppliers and developers of the Software claim trade
secret rights. Licensee may not modify, reverse engineer,
decompile or disassemble the Software.
Abracadata, Ltd. warrants to Licensee and to no other
person or entity that the physical media provided to
Licensee (but not the Software recorded on them or the
documentation), are free from defects in materials or
workmanship for a period of 30 days from the original
purchase date. Abracadata cannot guarantee that the
program will operate on all systems that meet the
minimum specifications indicated on the box. If during
this 30-day period a defect should occur, contact
Abracadata to obtain a return authorization number
before returning the product. Licensee’s sole remedy in
the event of a defect in the disk is limited to replacement
of the disk. As stated below, Abracadata disclaims any
and all implied warranty is found to exist, it shall
terminate no later than 30 days after purchase. If the disk
has been physically damaged, is beyond the 30-day limit
or is not accompanied by proof of purchase, include
$10.00 for each disk plus $3.00 postage and handling per
request. Please return the disk only, not the entire
package. Do not staple or paper clip the disk. Package
the disk carefully to prevent bending, and mark the
package Do Not X-Ray or Use Magnets. Ship via UPS or
U.S. Postal Service with return receipt requested.
Abracadata, Ltd. is not responsible for disks not received
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when Licensee cannot provide proof of shipment and
Abracadata, Ltd.s receipt.
This Limited Warranty does not grant and specifically
excludes any right to recover any other damages
whatsoever, including but not limited to, loss of profit,
loss of information, business interruption, or special,
incidental, or consequential damages or other similar
claims, arising out of the use or inability to use the
Software or documentation, even if Abracadata, Ltd. has
been specifically advised of such damages. In no event
shall Abracadata, Ltd.s liability for any damages to
Licensee or any other person ever exceed the actual price
paid for the Software, regardless of the form of the
claim.
In all other respects, the Software and documentation is
licensed AS IS, WITH ALL FAULTS. ABRACADATA,
LTD. SPECIFICALLY DISCLAIMS ALL OTHER
WARRANTIES REGARDING THE SOFTWARE AND
DOCUMENTATION, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO, ANY IMPLIED
WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Abracadata, Ltd.
specifically makes no representation or warranty that the
Software is fit for any particular purpose.
This Limited Warranty gives Licensee specific legal
rights. Licensee may have others, which vary from state
to state. Because some states or provinces do not allow
the exclusion or limitation of liability for consequential
or incidental damages, or the limitation on duration of
an implied warranty, some of the limitations may not
apply to Licensee.
Abracadata, Ltd. gives no assurance that the information
used in the development of the Software is reliable and
accurate. Any recommendations or suggested results in
the Software represent only the generic opinions and
judgments of the author and are intended to be
applicable in a variety of circumstances. However,
individual circumstances vary and may render certain
recommendations and results inapplicable. Abracadata,
Ltd. gives no assurance that the opinions or judgments
of the author are reliable or accurate.
If any provision of this License is held to be
unenforceable, it will be construed to have the broadest
interpretation that would make it valid and enforceable.
Invalidity or unenforceability of one provision will not
affect any other provision of this License. This License
shall be governed by the laws of the State of Oregon.
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Introduction
Congratulations and welcome to Design
Your Own Home 3D WalkAround! This
program is a powerful, flexible, easy-to-use
tool for drawing floor plans and architectural designs and viewing them in real-time
3D. Start by drawing the walls of your
home. Then add symbols to represent
doors, windows, cabinets, furniture, and so
on. View your layout in both 2-dimensional and 3-dimensional views simultaneously on screen as you are designing
your home. Add more symbols, experiment, rearrange, edit, and print out your
customized plans. You can also load one of
the pre-drawn floor plans that came with
your 3D WalkAround program and edit it to
your specifications. Other 3D programs
may show you what it is like to be in your
dream home by giving you still images of
the interior, but 3D WalkAround will
actually allow you to walk through your
own design.
We hope you enjoy 3D WalkAround. We
are sure that you will find that it makes
designing your home or office fun, easy and
fast!
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Using the Manual and Help
Design Your Own Home 3D WalkAround’s
only limitation is your imagination. You’ll find
examples in the manual to get you started and
to inspire you. These examples step you
through various procedures so you can learn to
use the program efficiently. Just follow the
numbered steps.
Be sure to use the Help (F1) option while
you’re operating the program to get specific
help information on the feature you’re using.

About the Team
Design Your Own Home 3D WalkAround is
brought to you by a team of professional designers, programmers, writers, testers, and
other business professionals who pride themselves in providing software that is dynamic,
easy-to-use, and enriches a particular aspect of
your life.
We would love to hear from you about Design
Your Own Home: 3D WalkAround or any other
Abracadata products that you use. And here’s
why: Most software is continuously updated
and enhanced over time. And YOU are one of
the best sources of information for enhancement ideas. We wrote the software for you; so
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if you want new features or have suggestions about how you’d like to see the program work in the future, please let us
know.

Technical Support
If you run into a problem using Design
Your Own Home 3D WalkAround, please
read through this manual, and the on-line
help (F1) for the solution. If you still need
help, please gather the appropriate information then call Abracadata’s technical
support number.
Remember, the technician will be trying to
solve your problem without seeing, hearing, or touching your computer—a mighty
challenge. He or she depends on you to
communicate precise information, sequentially ordered, succinct and yet detailed.
You and the technician are the detectives
on the case and you’re both depending on
each other to solve the problem. Neither
can solve it alone. So all facts need to be
communicated and examined so that the
right solution emerges.
Remember, too, that Abracadata technicians are trained at the task you are asking
them to do, and they are answering your
call precisely so that they can help you. If
you feel particularly frustrated by the
problem, first write down everything you
11

can think of about what happened, then
take a break before you call! Review your
notes, refine them and add to them. Your
role on the team is very important. The
more analytical you can be, the more calm,
polite, and precise you can be, the faster the
technician will be able to help.
Gather these facts and add them to your
notes before the call:
1. To determine what version of 3D
WalkAround you have, choose About
from the Help menu to find out the
version number.
2. What version of Windows are you
using?
3. How much memory is available on your
computer? Do you know how it’s
configured? If so, please provide that
information when you’re asked. (Example, you might have 8 megabytes
with 2 MB set up as a RAM drive and 2
MB set up for expanded memory in
DOS.)
4. What brand of mouse do you have?
What mouse driver are you using?
(Windows or the one that came with
your mouse)
5. What is your computer hardware
configuration? (Example: it’s a 386
running at 33Mhz)
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6.
What type of video display do you have?
(VGA or Super VGA) What resolution are you
using? How many colors?
7. What screen savers are you using?
(Windows or others)
8. What other programs are you running at
the same time? Are they Windows or
DOS programs?
9. Are you using a disk doubling or stacking program? Which one?
10. Which version of DOS are you using?

Tech Support Phone: (541) 342-3030
Hours: Monday - Friday 8:30 AM to 4:30 PM
Pacific Time, Fax: (541) 683-1925, 24 hours.
Internet: www.abracadata.com
America Online: Abracadata@aol.com

Address:
Abracadata
P.O. Box 2440
Eugene, OR 97402
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Chapter 1
Getting Started
The purpose of this manual is to give you
specific information (and a little inspiration) to use Design Your Own Home 3D
WalkAround. Please refer to your Windows
User’s Guide, the Readme.txt file and the
on-line help for information not found here.
We suggest that you proceed step-by-step
through the tutorial (Chapter 2) to get some
immediate hands-on experience with 3D
WalkAround. Use other sequenced examples
that appear in the manual for practicing
other functions. If you do these two things
and use help (F1) while you’re using the
program, you’ll be a 3D WalkAround expert
in no time.

Installation
Install 3D WalkAround from inside Windows. Insert the 3D WalkAround CD into
your CD-ROM drive. From within the
Program Manager choose Run from the File
menu. Windows 95 users click on the
"Start" button, then "Run". Type the letter
that corresponds to your CD-ROM drive,
followed by :\setup (e.g. d:\setup). Then
14
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follow the instructions as they appear. If
you wish to install the program to a different directory, select "Browse" when
prompted, then select or type in the destination path you with to install to. The
software will do the rest.

Starting 3D WalkAround
For Windows 95 users click on the "Start"
button, then "Programs", then "Abracadata
3D WalkAround", and select "Design Your
Own Home". For Windows 3.1 users, open
the Program Manager, then open the Abracadata group and double-click the Design
Your Own Home icon.
Once opened, you’ll see the Design Your
Own Home desktop. It consists of a row of
pull-down menus and rows of colors and
patterns across the top of the screen (the
Pattern/Color palette), icons in two rows
along the left side (the Tools palette, also
referred to as icons in the manual), and the
line palette, found below the icons on the
left.
We assume that since you own Microsoft
Windows you are already familiar with
using scroll bars, clicking and doubleclicking the mouse buttons, and dragging
the mouse. You are also very likely familiar

15

Chapter 1, Getting Started

with the pointer. We call the pointer (or
cursor) the Selector Tool in Design Your
Own Home: 3D WalkAround. You’ll also see
your cursor turn into small cross hairs
when you select one of the tools, and a
standard I-beam when you’re in text mode.
If you are unfamiliar with any of the above,
please review your Windows documentation or use Windows Help (F1) when you’re
in the Windows Program Manager.
Note: Keyboard shortcuts and commands
in this manual are referenced with key +
key combinations. For example, Ctrl + A
means to hold down the Ctrl key, then
press the A key, then let both keys go.
Never press plus. This is a standard you’re
probably already familiar with from other
Windows programs.
If you don’t have a mouse, please refer to
the Appendix-Keyboard Use, to learn how
to use 3D WalkAround without a mouse.
Also, read the Windows manual to learn
how to use Windows without a mouse.

16
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Chapter 2
Tutorial
We recommend that you work through this
tutorial chapter from beginning to end
because once you’ve done so, you’ll be on
your way to becoming a 3D WalkAround
expert.
In this section, we’ll draw a simple room
plan and tell you how to add predrawn
symbols to your drawing.
One basic concept that you must become
familiar with in order to get the most benefit from 3D WalkAround is that two applications are used together. The first is a 2D
home design package to help you lay out
your floor plans and add symbols to represent furniture, doors and windows. The
second is a 3D viewer which operates
simultaneously as you are constructing
your home, and lets you walk through and
view your design room by room.
Before starting, you’ll need an empty drawing window. If you just started 3D
WalkAround , you’ve already got an empty
drawing window; if you’ve been working
on a practice floor plan, you’ll need to open
a new file.
18
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To open a new file: Choose New from the
File menu. Since you probably haven’t
saved your file, a dialog box appears,
telling you (Untitled) has changed, and
asking whether you want to save those
changes before closing. For now, click No.
If you want to save the file, click Yes and
the Save As dialog box appears, allowing
you to name the drawing. To save the file
on a different drive, click the Drives box,
then click on the drive where you want to
save the file. To save to a different directory, double-click the directory you want in
the Directories box. Type a name for the
file in the File Name box, then click OK.
File names are limited to 8 characters,
followed by a 3-letter extension. You do not
need to type the .YOH extension; the program will add it to your file name. An
example of a file name is
MYDRAWNG.YOH. The file is saved to
disk, removed from the screen, and a new,
“Untitled” window is opened.
If you have already named the drawing
because you’ve saved it earlier, the file is
automatically saved with its current name,
then removed from the screen, and a new,
“Untitled” window is opened.
To be sure your drawing will fit on an 8.5"by-11" sheet of paper, go to the Layout
pull-down menu, and select Drawing Size.
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You will see a drawing size that’s appropriate
to your default printer. You may leave the
drawing at its default size, or enlarge it by
using the TAB key to move from box to box
and typing in new values, or you can click
your mouse in the box you want to change.
Drag the mouse over characters you want to
replace or use the backspace key to edit. You
may also select Metric or English measurements in this dialog. After you have selected
your settings, click OK.
Now we’ll create a simple two level living
room/dining room plan. Then we'll use
several of the program's features to complete
the plan and walk through it.
1. First, click on the 3D icon (located on the
bottom right of the tool bar) to open a
3D window. This will allow you to see
your room in a 3D view while you are
drawing. 3D WalkAround displays the
3D view in a separate window from the
2D drawing. Select Automatic Update
from the 3D Menu, if it is not already
checked. Also select 'Snap to Grid' from
the Layout manu. Then select "Preferences" from the Layout Menu and make
sure all five boxes on the left-hand side
have check marks in them. If any boxes
are unchecked, left-click with your
mouse in the appropriate boxes until all
five boxes are checked, and then click
OK to exit back to the 2D View. We will
20
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explain more about selecting Preferences in
Chapter 4. You need to arrange the two windows so that it's easy to switch back and forth
between the two views. To do this, size the
two windows equally, one at the right side and
one at the left. This allows you to see the 3D
view being automatically updated as you
make changes to the 2D view. You also could
maximize both windows by double-clicking on
the title bar of either one, and then switch back
and forth between them by pressing Alt+Tab.
When you click the mouse on the 3D View
window it becomes the active window.

Wall
Tool

2. Click on Drawing Size, located under
the Layout menu at the top of the drawing screen. This will bring up the Drawing Size dialog window. Here, you can
select between English or Metric measurements, as well as your target printer
and drawing size. For now, choose
English Inches if it is not already selected. Leave the drawing size at its
default setting. Click OK to finalize.
3. Click on Drawing Scale (under the
Layout menu). Select the 1/4" scale and
click OK. Now we will draw a wall in
the 2D view. Select the wall tool. It’s the
fourth icon up from the bottom left of
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Figure A.

the tool palette. Place the cross hair in
the upper lefthand corner of the 2D
drawing window (Figure A).
While holding down the left mouse
button, drag a line horizontally to the
right. Notice the measurements appearing at the right end of the wall as you
draw. Keep the left mouse button held
down and extend your wall to the right
until it reaches 14'4" and is perfectly
horizontal. Now release the mouse
button and your wall should appear in
both the 2D and 3D views. Earlier, we
selected the 'Snap to Grid' option from
the Layout menu. This allowed you to
draw a perfectly straight wall by automatically "snapping" the end point of
the wall to the nearest gridpoint. If your
wall did not come out exactly right, go
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`

Selector
Tool

up to the Edit menu and choose 'Undo'.
This will reverse your last action so you
can start over.
Next, in the same manner, draw a 12' 0"
wall vertically, down the left hand side
(see figure A). In the 3D view, you will
see two walls and a floor. Left-click on
the selector tool icon. It's the top-left
icon on the tool palette. Now, select the
vertical wall that you drew in the 2D
window by left clicking on it. Hold
down the CTRL key and simultaneously
press the D key. This will duplicate the
wall that you just drew. Select your new
wall by clicking on it with the left
mouse button. Now hold down the
mouse button and practice moving your
wall around the 2D view. Place your
wall opposite the first vertical wall (see
figure B).

B

C

A

D
Figure B
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In the 3D view, you should see a floor.
This is the default floor. We want to
replace the default floor with our own
floor, which we will draw now.

Floor
Tool

4. Select the floor tool. It is the bottom left
icon on the tool bar. Place the cross hair
on the lower left wall end at point A and
left click your mouse (see figure B). This
will drop your first floor point. Move the
cross hair to point B and left click again.
This will drop your second floor point.
Repeat this procedure through points C
and D. From point D, draw the final line
back to point A. When you reach point A,
right click the mouse to finalize your floor.
In the 2D window, you should now see a
floor and three walls (figure C).

B

C

A

D

Figure C
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5. Click on the selector tool icon and then
right click the floor object and then click
the 3D Info button. Set both the Floor
Altitude and Floor Thickness to 1'. Click
OK to finalize.
6. Select a different wall color by right
clicking on a color in the color palette at
the top of the 2D screen. This will make
it easier to tell your walls apart in the
next step. Select the Wall Tool again
and draw a new 12' vertical wall starting
at the bottom of the left hand wall and
extending downward. Select this wall
and make a copy of it using the 'Duplicate' command in the Edit menu. Place
the copy at the bottom of the opposite
vertical wall. Make sure that the bottom
points of the two new walls are even in
the 2D view. (Figure D).

Figure D

Figure E

7. Now select the floor tool and draw a
floor for the bottom portion of this
room. Leave the default altitude and
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thickness for this floor. You should now
see the equivalent of figure E in your 2D
window.
8. In the 3D window you should see a split
level room. By right clicking on one of
your floors in the 2D viewer and then
clicking on the 3D Info button, you may
change the texture. Select the Top Side
of the lower level floor and place a
different floor texture on it. Choose a
tiled texture to simulate a kitchen or
dining room floor. Repeat this procedure for the top floor, only this time
place a light colored carpet. Your 3D
window should now look like the one
below (Figure F) We are now ready to
place furniture.

Figure F
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Picture
tool

Placing 3D Objects
1. To place furniture objects in 3D
WalkAround, first click on the Picture
Tool. The selector tool will turn into a
cross hair. Click the cross hair on the
spot in the 2D window where you want
the object to be placed. This will bring
up the Select Picture To Insert window
(Figure G).

Figure G

In the File Name dialog, the file should
read, *.awl. File Type should be set to
Architecture. The Path setting should
be set to the Lib directory. If you performed the default installation, it would
read as follows:
Path: C:\Abra\3DWalk\Lib
If you set your install directory to a
different path, you will need to modify
the path so that it points to the Lib
directory! You may modify the path in the
Directories window.
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In the Files window, you will see all the
different library names that have an .awl
file extension. These are the different furniture and object libraries.
Scroll down and select the library called
furn.awl. You will then see objects appear
in the large window to the right.
2. Scroll down and select the table w/4 chairs.
You may either double click on the object or
click it once and then click on the Paste
button to place the object. A dialog will
pop up telling you that the object you
selected has been pasted into your drawing.
Now repeat this procedure and paste the
tall cabinet, wood. Click Close to exit the
library window.
3. In the 2D window, you will see the two
furniture objects you just placed. Place the
table w/4 chairs in the center of the lower
part of the room. Select the cabinet with the
selector tool. Press CTRL+L to rotate the
cabinet to the left and then place it against
the left hand wall as in Figure H.

Figure H
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4. Select the picture tool again and click on the
2D view to open the library dialog. Choose
the library called seating.awl. Now select the
first sofa object, called 7' Sofa01a and paste it
into your layout. Next, go to the misc.awl
library, and place the aquarium. Then find the
lamps.awl library and place FloorLamp3a. Go
to the tv_audio.awl library and place the 25"
Television. Next, find the tabled.awl library
and place the object called Table,Baby 3'x2'7.
Finally, choose the library called
Windw3ft.awl and place the first object, called
Wnd, 1-pane 3'xs4'2. These will go into the upper
part of your drawing, but before they do, you will
have to reset the height on each object except the
window. To accomplish this, right click on each
object and select the 3D Info button. In the dialog,
Height Above Ground, enter the value of 1'. This
will set the object on top of the 1' thick floor that
you created. Set the height of the television at 3.5
feet. Use the CTRL+L or CTRL+R to rotate objects
in 90 degree increments. For single degree rotation, use CTRL+1 (to rotate left), and CTRL+2 (to
rotate right) and place them so that they match
Figure I.
Smart doors/windows: 'Note that when you place
your window against the wall, the window is
essentially poking a hole in the wall, eliminating
that section of the wall so the textures don't show
through. Placing a door against a wall will cause
the same effect.
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We are now ready to add textures to our dining
room walls.

Figure I

Applying Textures
Applying textures in Design Your Own Home
3D WalkAround is as easy as clicking your
mouse. Just follow the steps below and you'll
soon be on your way to being an interior
decorator.

Texture
button

30

1. We'll first start off with wallpaper.
Right click on the lower left hand dining
room wall (the one with the large
wooden cabinet in front of it.) In the
Object Information dialog, click the 3-D
Info button to bring up the Wall 3-D
Display Info. Now click the Texture
Button to the right of the Right Side text
field. This will open the Texture
Viewer.

Chapter 2, Tutorial

2. Once in the Texture Viewer (Figure J),
you will see all of the different wallpaper patterns available to you. Whenever you select a wall, the viewer will
automatically default to wallpaper
textures for walls, floor textures for
floors, and fabric textures for most
furniture. You may, however, select
any texture from any category you
wish. If you want to place a floor texture on a wall, simply click on Floors to
bring up the floor textures. For the time
being we will select a wallpaper texture.
Click on the first wallpaper texture
(located in the upper left hand corner of
the viewer). Click OK to go back to the
Wall 3-D Display Info dialog window.
You should see the texture name
wall001.bmp in the Right Side text field.
You may also type these texture names
in if you wish.

Figure J
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3. Click OK to finalize your texture
selection or repeat the same procedure for
the right hand wall, only this time,
set the texture on the left side.
4. Repeat the above steps to add textures to the living room left and right
side walls. For the back wall, place
the texture on the left side of the
wall.
Applying floor textures
3D Walkaround has a default floor texture
that is applied to all floor objects in the
program. If you wish to change this default
texture, select Preferences (under the Options menu) and click on the Texture
Viewer button to the right of the Floor
Texture File field. Select the new default
floor texture and click OK.
To change a floor texture on a new floor
object that you have drawn, right click on
the floor and then click the 3D Info button.
Select the Top Side option. This will apply
a given floor texture to the top and sides of
the floor object. Select the floor's thickness
and altitude.
Scaling Floor Textures
Changing the texture Scale setting in the 3D
Info Window allows you to modify the
scale at which textures appear in the 3D
window. The number in the Texture Scale
32
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box will remain at zero until it is changed. The
default setting for any texture is 100. At this
scale the texture will appear on the object
unchanged. If the number is raised above 100,
the texture will be stretched out in proportion
to the increase. Likewise, lowering the Texture
Scale amount below 100 will scrunch the
texture in proportion to the decrease. Any
number from 0 to 9999 may be used. This
feature is also available on wall textures. Now
you're ready to add a roof to your design.
Adding the roof
Before we add the actual roof pieces, we need
to construct a couple of wall pieces that will
attach the far wall to the roof. Select the wall
tool and start drawing a wall from the middle
of the top (horizontal) wall. Make sure that
you start exactly on the centermost point of the
wall, otherwise, your walls won't fit your
structure correctly. Stretch this new wall directly to the left, until it reaches the top right
corner of your structure. At this point, let go of
the mouse button, and your new wall piece
will pop into view. Now, right-click on the
wall piece and click on the 3D Info Button so
that we can change the height of the wall.
Once in the 3D Info window, change the 'Elevation of Wall' figure under 'Whole Object' to
8'. Set the 'Height of Wall' at point 1 to 2' and
Point 2 to 0'. Click OK to exit back to the 2D
and 3D views, and you should see the new
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wall pop into place atop the left portion of the
far wall. Now, select 'Duplicate' from the Edit
Menu to make a copy of this wall. With this
duplicate wall selected, use the CTRL+R
function on your keyboard twice to rotate the
wall so that it appears as a mirror image of the
original. Place the copy so that it sits atop the
left portion of the far wall. Finally, add textures to these upper walls so that they match
the rest of the interior. Now we're ready to
design the roof.
Select the floor tool, and start drawing a floor
by left-clicking at the gridpoint just to the right
of the lower right corner of your structure.
Starting at this point will provide a little bit of
overhang to the roof. Drag the drawing line
left and click at the bottom center of the lower
floor. Draw a line straight up and left-click at
the top center of the upper wall. (This should
be the same point at which you started your
wall that you just created.) Draw the next line
out to the gridpoint just to the right of the
upper right corner of the structure and leftclick. Finally, drag the last line down to where
you started and right-click. A floor object
should appear in the 2D view. Right-click on
the lower right corner to bring up the 'Object
Info' window, and enter the '3D Info' window.
Now, we will transform the floor into a roof.
Change the Altitude for Point 1 to 7.8'. Notice
the small diagram showing Point 1 of the floor.
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Click on the right arrow next to the diagram to
change the window to show Point 2. Set the
Altitude for Point 2 to 10'. Go to Point 3 and set
the Altitude to 10'. Set Point 4 to 7.8'. Now,
select a texture that you would like to see on
the bottom of the roof. Click on OK and exit
back to the 2D and 3D Views. You should see
the right half of the roof appear in the 3D view.
To add the left half, simply duplicate the right
portion, rotate it by using the CTRL-R function
twice, and set it into place opposite the right
half. Your structure should now be complete!
If it doesn't look quite the way you expected it
to, or if you want to change anything at all, feel
free to experiment with this tutorial until you
feel totally comfortable with the basic functionality of the program. 3D Walkaround allows a
great deal of flexibility, so you can design your
home exactly the way you want. Now, let's
move on to some of the program's additional
features.

Constructing simple 3D objects
We will now cover the procedures on constructing simple 3D furniture objects using the
floor and wall tools. We will construct a cabinet and then add it to the tutorial object library.
1. Go up to the Layout menu and turn
'Snap to Grid' OFF. Turning this function off will be necessary for precise
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Figure K

Box
Tool

Figure L

measurements. Use the down scroll
arrow to bring the current tutorial
layout that you have been working on
up so that you have some blank space
below it to work in (Figure K)
2. Select the Box Tool. We'll use this to
make a template for the main body of
the cabinet. Draw a rectangle that measures 6' long and 2'6" deep (Figure L).
3. Select the floor tool and use it to trace the
outline of the rectangle that you just drew.
When you finalize the last line, the new
floor piece will automatically be sent to the
back. Select the first rectangle template
that you drew and delete it. You should
now be left with just the floor piece that
you drew.
4. Right click the floor object and click on
the 3D Info button. Set the Floor Thickness and Floor Altitude to 3'. Now we
will change the texture of our counter.
Normally, you would select the new
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textures by bringing up the texture
viewer and selecting the textures from
there. For now, we will simply type the
texture names in manually. In the Top
Side texture field, type ashsen.bmp. You
may type the same texture name in the
Bottom Side field, or leave it blank.
Click OK twice to finalize and exit.
5. Repeat the process but this time make
the object 6'6"x3'. Set the thickness to 2"
and the altitude to 3.2'. After you have
done this, assign the texture file name of
floor062.bmp to the object. This object
will serve as our tiled counter top.
Select and place the 3' thick object that
you drew earlier and center it on the
counter top object but do not send it to
the back yet.
6. Now draw a horizontal wall that is 2'6"
long. Right click on the wall and click
on the 3-D Info button. Change the
height of the wall to 2', the elevation to
.5, and the thickness to 1". Now type in
the file name ashsen.bmp on the left side
of the wall. With this new wall piece
selected, press CTRL+D to duplicate it.
This will give you two walls which will
be used as cabinet doors. Arrange both
wall pieces to match Figure M.
7. With all of the pieces placed, the object
is now ready to be grouped. Hold
down the left mouse button and draw a
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Wall pieces
Figure M

Picture
tool

marquee box around all of the pieces.
Once all of the pieces are selected, press
CTRL+G to group them all together.
Now, with the object still selected, hold
down the CTRL key and click on the
Picture Tool icon on the tool bar. This
will place you in the Save Picture In
Library window. Select the Tutorial
library. You will see all of the current
objects that are in that library appear in
the window. Click on the Add button
and type in a name for your new object,
then click OK. Your new object is now
part of the Tutorial library and may be
used in future designs.
8. To delete an object that you no longer
wish to use, go to the Save Picture In
Library window and select the object by
single clicking on it. Click Delete, followed by Yes. This will permanently
remove the object from the library.
Click Close to exit.
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Changing the lighting in the 3D viewer
Turn on the lighting function by either pressing CTRL+L or by clicking on the lighting
mode feature in the 3D Window (represented
by the center light bulb). Turning this feature
on will change the brightness and contrasts
rendered in the 3D viewer and shade the
surfaces more realistically. When this feature is
off, each surface has a single lighting level.
You can brighten the lighting level by pressing
F2 or by clicking on the brighten feature in the
3D Window (represented by the right light
bulb.) To darken the lighting, press F3 or click
on the darken feature (left bulb) in the 3D
Window. Continue to press these function keys
until you can see each symbol's details. Note:
sometimes it appears that some objects such as
white kitchen cabinets, don't have doors. This
is a problem of the lighting being too bright on
your system. Press F3 repeatedly until you can
see more details in the objects.

Changing the Heights of Symbols
You may want to change the height of some of
the symbols. For example, you may want to set
a lamp on a table. To change the height, select
the object in the 2D Window and right-click on
it. This will bring up the Object Information
Dialogue Box. Click on the 3D Info Button and
you will see a 3D Info Display Window. The
display windows for walls and floors appear
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slightly different from those for other objects.
In these windows, you can change the altitude
and thickness of a floor, height and elevation of
walls, and altitudes of other objects. You will
not notice any changes you have made to an
object until you exit the 3D Info and Object
Windows.

Changing an Object's Texture
You can change the texture of an object by
entering the name of a bitmap file or by selecting a texture through the Texture Viewer. All
bitmap files are located in the data
subdirectory.
If you would like to use your own bitmaps
(BMP format) as textures for symbols, copy
your bitmap into the DATA subdirectory of the
3D WalkAround directory. You can then
access them just as you would the bitmaps
provided with this program.

Line Palette
Line thicknesses and styles apply to both the
thickness and style used for lines and to thickness and style used for other drawing-tool
objects’ borders.
The line-end styles (the four lines on the bottom of the palette) apply only to objects drawn
with the line and constrained-line tools.

40

Chapter 2, Tutorial

A bullet appears beside the currently selected
line thickness or style, and line-end style. To
change to a different thickness, style, or end,
just click on a new one.
Note: the funny-looking “line” at the top is the
invisible line. Use it when you don’t want an
object to have a border (especially if you have
an object background that is a pattern and you
want the whole object to be filled with the
pattern from edge to edge).
The three lines below the “invisible” line may
look the same on your monitor and printouts.
However, they are different from each other.
The top one is the thinnest possible line that
will show up on any monitor or printer. It will
show up as one pixel thick on your screen, and
it will show up as 1/600 thick on a 600 dpi
laser printer, 1/300 thick on a 300 dpi, 1/150
on a 150 dpi, etc. Use Zoom (Ctrl+Z) after
drawing a line of each thickness to see the
difference.

Pattern/Color Palette
The box at the left end of the pattern/color
palette contains a rectangle that displays the
working line color and the working fill pattern
or color. Call this the “working rectangle.”
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The line color is used for object borders, text
colors, and interior lines. The fill pattern or
color is used for object interiors and text background. The minus symbol at the bottom left
position in the palette lets you create objects
with transparent interiors. To create a transparent border see Line Palette.

Changing a Symbol's Patterns
Changing a Symbol’s Patterns
3D Walkaround treats a symbol as a single
object unit. This means that if you select a
symbol and choose a color or apply a texture,
all the components of the symbol take on that
color. You can also select several objects and
change their colors and patterns, just as you
would a single or grouped object. Just draw a
box around the objects using the Selector Tool.
You can use patterns or colors for filling object
interiors. You can use colors for drawing lines
and object borders.
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Note: Colors operate the same for both line and
fill, but patterns work differently. You cannot
use a pattern for a line or border.
To change a fill color or pattern:
Click on a color or pattern with the left mouse
button and you will see the working rectangle
change color or pattern.
To change a line color:
Click on a color with the right mouse button to
see the working line color change.
To change the fill color of the pattern palette:
Hold down the Ctrl key and click the left
mouse button on the color you want to use. If
you have mixed (dithered) colors in the top
row of the color palette, you won’t be able to
change the fill color to one of these, but the fill
color will approximate the dominant color in
each mixed color as you click on it.
To change the line color of the pattern palette:
Hold down the Ctrl key and click the right
mouse button on the color you want to use.
To see more colors and patterns on the palette:
Click and hold the arrow keys at the right end
of either the color palette or the pattern palette.
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Creating New Patterns
You can create a new pattern or edit an existing
one with Edit Pattern in the Options menu.
Select this option and the Edit Bitmap Pattern
Dialog appears. The scroll bar at the bottom of
the dialog shows all the current patterns in the
pattern palette from left to right.
To edit a pattern or create a new one:
Select one of the patterns. Next, clear the selected pattern by clicking the Clear Pattern
button or just start with the selected pattern and
make changes to it by moving the cursor to any
square and clicking it. A black square will
change to white. A white square will change to
black. On the right you’ll see the effect on the
pattern. Changing even one square can have a
startling effect on a pattern. Try it.
Once the pattern is the way you like it, you need
to decide if you want to replace the pattern you
started with or save a new pattern.
To save a new pattern:
Click Save As New. A dialog asks if you want to
create a new fill pattern. Click Yes. Scroll the bar
at the bottom of the dialog and you’ll see the
new pattern on the right most end. Click OK to
close the dialog and you’ll see your new pattern
at the right most end of the pattern palette.
Scroll the palette with the right arrow to see it.
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To replace a pattern:
Click Save Pattern. A dialog asks if you want
to modify the selected fill pattern. Click Yes.
The pattern you changed will replace the
original pattern. Click OK to close the dialog.
The new pattern will replace the original one.
Note: When you change the pattern palette
you must save your drawing in order to save
the new palette. This way you can have a
custom palette for each drawing. If you wish to
save a default palette to use with all of your
drawings, we suggest the following:
Modify the pattern palette so it is the way you
want it. Then save a drawing (with one object
only) called “mypalette” or “default.” Choose
a name that means something to you. Then
each time you start the program you can open
that file, delete the one object in it and start a
new drawing. Be sure to use Save As to save
the new drawing so you don’t overwrite your
default file.

Creating New Colors
You can create a new color or edit an existing
one with Edit Colors in the Options menu. A
color is defined by its hue (its position in the
color spectrum), saturation (the purity of the
hue-from very gray to the pure color), and
luminosity (its brightness from black to white).
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To define a new color select Edit Colors in the
Option Menu and the Edit Color Dialog appears.
The existing palette colors show in the Palette
Color box. If your palette has more than 40
colors, use the scroll bar below the Palette
Color box to see additional colors. If you click
on any of the existing colors you’ll see the color
refiner cursor move to different areas of the
color refiner box on the right, and you’ll see the
vertical luminosity indicator move on the
vertical luminosity bar to the right of the color
refiner box.
To modify an existing color:
Select a color and drag the color refiner cursor
to the color that you want. Then drag the
arrow next to the vertical luminosity bar up or
down to adjust the brightness.
As you change the color, the new color is
displayed on the left side of the Color|Solid
box. The right side of the box shows the solid
color that is closest to the color chosen.
Once you have a color you want, you need to
decide if you want to replace the color you
started with or save a new color.
To save a new color:
Click OK. This will take you back into the
design window. Click on the Option menu
and then Save/Load Color Palette. Select the
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Save Color Palette option. This will bring up
the Save Palette dialog box. Type in the name
that you wish to give your new palette and
then select the save location in the Directories
window. Click OK when finished. This will
save your new color palette with a .pal extension.
To replace a color:
Select Edit Color under the Options menu. In
the Palette Colors window, click on the color
that you wish to modify. This color will
appear in the Color|Solid box. To modify it, grab
the black cross-hair and move it to the new
color. You may also adjust any of the numeric
values located below the color window. Click
replace when finished. The program will then
ask if you wish to modify the selected color.
Click Yes to finalize your choice or No to
cancel. The color you originally selected will be
replaced by the new color. Click OK to close
the dialog. The new color will replace the
original one in the Color Palette.
Note: You can save the new palette by using
the Save/Load Color Palette menu option.

Create Your Own 2D Library Symbols
You can easily create your own libraries of 2D
WalkAround symbols; however, these symbols
will not appear in the 3D WalkAround view.
To do so you must first have an object or
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grouped object on the screen. Select the object
you want to place in a library and then
Ctrl+click on the picture frame icon. You’ll see
a special dialog where you can either create a
file for your library or select an existing library
file to add your picture to.
In the File Name box you see *.awl, which is
the default extension for 3D WalkAround
Windows Libraries. If there are existing *.awl
libraries in the drive, path, and directory selected, you’ll see a list. You might want to
change the path if you don’t see any *.awl files
listed. You should also see your shape in the
Selected Object box.
To create a new library file, type a name for the
new file in the File Name box and hit Enter.
(You do not need to type the AWL extension; it
will be added automatically.)
When you select a library file name, the symbols (if any) in that library appear in the viewer
on the right hand side of the dialog.
To add the new object to the new or to an
existing library click the Add button. The Enter
Object Name dialog box appears. Enter a name
for your object and press Enter, or click OK.
Your object is now available to use over and
over with 3D WalkAround’s Picture Tool.
To change the name of an object, select the
object and click the Edit button.
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To delete an object from the library, select the
object and click the Delete button, and reply
Yes when the program asks you to confirm that
you want to delete the object. Be careful —
there is no Undo for this operation.
If you get a “File Full” message when you are
adding a picture to an existing file, it means
that you need to start a new file. Each library
file’s size is based on the size and complexity
of the component pictures or objects in it,
rather than the number of objects the file contains.

Create Your Own 3D Library Symbols
You can create your own 3D library symbols
for objects that you've created in the 3D View.
Once you have created your object (such as the
cabinet from the tutorial), use the Screen Capture function, which is common on most systems. (Usually, pressing the key labelled 'Print
Scrn SysRq' located above the insert key will
perform this function.) Once you have the
desired 3D view copied onto your Clipboard,
you can open a drawing program that handles
.tif files and Paste the contents of the Clipboard
into your drawing program. Edit the picture to
your desired specifications and save the file as
a .tif file. You can then insert the file into an
existing library, or it might be a good idea to
create a new library for your own 3D objects,
In this way, it's possible to create whole rooms
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and display them as 3D objects libraries. You
will have to experiment with setting the .tif
files to the proper specifications for viewing in
3D Walkaround.

Importing Other File Types
1. After you’ve drawn the picture frame
and you see the Select Picture to Insert
dialog, select the directory where you
have placed the file that you want to
import.
2. If you don’t have any particular file you
want to import, select the Windows
directory for an example.
3. To see any files listed, go to the List Files
of Type box, click the little arrow, and
then select Windows Bit map (.BMP).
Several .BMP files should appear in the
File Names list. Or select another file
type if you want to import another type
of file.
4. Select a file and you’ll see a picture in
the picture box. Select OK to place the
picture in your 3D WalkAround drawing.
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Importing DXF files
Design Your Own Home 3D WalkAround now
has improved DXF file support. It is possible
to import DXF files into your drawings by
following the steps below.
1. Click on File, then Open. This will bring
up the Open Drawing dialog.
2. Set the List Files of Type to AutoCAD DXF
files.
3. Select the file name and path that you wish
to open and click OK.
4. Once the drawing has been imported, you
may edit it by first ungrouping the object
(CTRL+U) and then selecting the indi
vidual lines you wish to edit. When fin
ished, you may then regroup the object
(CTRL+G).
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While laying out your floor plan in the 2D
view, Design Your Own Home: 3D WalkAround
offers you an array of drawing tools. These
tools will not change the 3D view of the symbols. Only the symbols which you have placed
into your layout will appear in the 3D viewer.

Arc Tool
To draw an arc:
Select line pattern and fill pattern. Set line
thickness or style by clicking the appropriate
icon on the line palette, then click the arc icon
on the tool palette.
Move the cross hairs to the place on the drawing area where you want to begin drawing the
object. Press the left mouse button to anchor
one end of a flexible arc. Drag the cross hairs.
The flexible arc stretches from the anchor point
to the mouse position. If you pull the arc down
and to the right, it will curve out to the right.
Pull it down and to the left to make it curve to
the left. Notice that the screen scrolls smoothly
if you try to extend the arc off the edge of the
current window.
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When the arc is the size and shape you want,
release the mouse button.
To draw a wedge or pie piece, hold down the
Shift key when you click the left button to start
drawing.
To draw a chord, hold down the Ctrl key when
you start drawing.
To force an arc, wedge or chord to be circular
(i.e. to be a section of a circle), press the Ctrl
key after you have started to draw it.
You can change an existing arc in two different
ways. You can resize it the same way you
resize other objects, but you can also adjust the
position of its vertices.
To adjust the vertices of an existing arc, position the selector tool over the object, hold down
the shift key and click. If the arc was not already selected, standard handles will appear.
Shift-click again and handles will appear at
each vertex. (A third Shift-click makes all
handles disappear.) You can drag each vertex
to increase or decrease the amount of arc. As
you move a vertex, the angle of the vertex from
the X-axis (i.e. from the line that points in the 3o’clock direction) is displayed at the centerpoint of the arc.
To make an existing arc circular, press the Ctrl
key while you move one of its four standard
handles.
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Rectangle Tools
These tools draw rectangles with straight or
rounded corners.
To draw a rectangle or box:
First, select line pattern and fill pattern. Set the
line thickness or style by clicking the appropriate icon on the line palette, then select one of
the rectangle tools by clicking the appropriate
icon in the tool palette.
Move the cross hairs to where you want to
begin drawing the rectangle. Press the left
mouse button to anchor one corner. Drag the
cross hairs. A flexible box stretches from the
anchor point to the mouse position. Notice that
the screen scrolls smoothly if you try to extend
the rectangle off the edge of the current window.
To make a perfectly square box, press the Ctrl
key while you drag.

Circle/Ellipse Tool
Draws a circle or ellipse.
To draw an ellipse:
Select a line pattern and a fill pattern, set a line
thickness or style by clicking the appropriate
icon in the line palette, then click the ellipse
icon on the tool palette to select it.
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Move the cross hairs to where you want to
begin drawing a circle. Press the left mouse
button to anchor one side of a flexible circle.
Drag the cross hairs. The flexible circle
stretches from the anchor point to the mouse
position. Notice that the screen scrolls
smoothly if you try to extend the circle off the
edge of the current window.
When the circle is the size and shape you want,
release the mouse button.
To make an ellipse a perfect circle, press the
Ctrl key as you drag.

Line, Constrained-Line, and
Hollow-Line
All three tools draw lines. The constrained-line
tool draws lines at vertical, horizontal, and 45
degree angles.
To draw a line:
Select a line color by clicking the right mouse
button on a color on the top row of the color/
pattern palette. Set line thickness or style by
clicking the appropriate icon on the line palette, then select the line, constrained-line, or
hollow-line tool by clicking the corresponding
icon on the tool palette.
Move the cross hairs to the place on the drawing area where you want to begin the line.
Press the left mouse button to anchor one end
of the line. Drag the cross hairs. A flexible line
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stretches from the anchor point to the mouse
position. Notice that the screen scrolls
smoothly if you try to extend the line off the
edge of the current window.
When the line is the length and orientation you
want, release the mouse button.
To constrain an already existing line, or to
constrain a line after you’ve begun to draw,
press the Ctrl key while you edit and drag the
line by one of its handles.
Note: You can adjust the width of the hollowline borders by choosing a different line thickness from the line palette. You can change the
width setting for the hollow-line tool by increasing or decreasing the number of units in
the User Preferences dialog under the Options
menu.

Magnifying Tool
This tool lets you zoom in on a particular area
of your drawing. You can draw and edit just as
you normally do on the full screen.
To magnify an area of your drawing:
Click the magnifying tool icon on the tool
palette, then move the cross hairs to the place
on the drawing area you want to magnify.
Press the left mouse button to anchor one
corner of a flexible box. Drag the cross hairs
over the area of your drawing that you want to
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magnify. Notice that the screen scrolls
smoothly if you try to extend the box off the
edge of the current window.
When the box encloses the area you want to
magnify, release the mouse button. You may
also click once on an area to zoom in.
To return to normal view, use the Restore
option under the Layout menu.

Measuring Tool
The measuring tool allows you to measure the
distance between any two points on the screen.
That distance will be displayed in the working
unit of measurement.
The measurement shown will appear on screen
only as long as you hold down the mouse
button. Use a dimension line if you want to
keep a measurement on screen.
To measure:
Click the measuring tool icon on the tool palette, then move the cross hairs to the place on
the drawing area where you want to begin
measuring. Press the left mouse button to
anchor one end of the line. Drag the cross
hairs. A flexible line stretches from the anchor
point to the mouse position, and the length of
the line appears in the center. Notice that the
screen scrolls smoothly if you try to extend the
line off the edge of the current window.
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When you’re done measuring, release the
mouse button.
To constrain the line (drag at 45 degree angle),
press the Ctrl key while you drag.

Picture Tool
The Picture tool is one of 3D WalkAround's
most powerful features, and it’s what makes
3D WalkAround special. You’ll use this tool to
insert 3D WalkAround libraries or bit-mapped
pictures into your art work. You can import
numerous file types that you’ve created with
other programs. With it you also create your
own libraries.
To insert a picture: Click the picture icon on
the tool palette. Move the cross hairs to the
place on the drawing area where you want the
picture to be. Drag the cross hairs over the
drawing area until the insertion box is the size
and shape you want. (The insertion box will be
a dashed rectangle that won’t stay on your
drawing. It’s just an outline for the picture you
select from the Select Picture dialog.)
Note: You can constrain the insertion (picture)
box by holding the Ctrl key down while dragging the box.
When you release the mouse button, the Select
Picture dialog appears.
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Caution: If you ungroup a symbol you will no
longer be able to view it in 3D WalkAround.
An imported symbol may consist of dozens of
small shapes. You’ll know the magnitude of
the number of shapes when you ungroup the
symbol. If you see dozens of handles, you’ll
know there are a lot of component shapes.
Regroup the object before you do anything,
move it to a clear part of your drawing window, then ungroup it again. It will be easier to
manipulate the individual parts of the shape
and regroup it if you don’t have any other
objects from your drawing in the vicinity.

Selecting a Picture
When you see the dialog, click through the
various file types which include: Architecture;
Windows Bitmap(BMP); Windows
Metafile(WMF); PC Paintbrush(PCX); DYOH
2.1 Libraries; and All files. Be sure to click on
the first file type called Architecture to list and
access the 3D WalkAround symbols. All 3D
WalkAround symbols have a .awl extension. If
you don’t see any file names under the file
name dialog, use the directory dialog in the
center to click on the 3D WalkAround "lib"
directory (or another directory, if you have
libraries in another location).
To insert a picture:
1. First, select the type of picture you want to
insert from the File Type list, and be sure
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you’re in the directory where the picture is
located. If you don’t see the file names you
want in the Files box, double-click on the icons
in the Directory box to move to the correct
directory.
2. Click the file name of the file or library you
want to examine. You’ll see the available
pictures appear in the box on the right-hand
side of the dialog. If the file contains a lot of
pictures, a scroll bar will appear in the box to
let you scroll up and down and look at them.
(If the box stays black, the file does not contain
any importable pictures.)
3. If the box contains more than one picture,
click on the picture you are interested in. To
insert the picture in your drawing, click the
Paste button.
4. If you want to insert other pictures, or more
copies of the same picture, repeat the above
procedure as often as you like. When you’re
done, click the Close button to return to your
drawing.
New Improved Library Object Views:
In version 3.0 (or later) of 3D Walkaround, the
library objects are represented by .tif files,
giving the objects a 3D appearance. If you
desire to see the objects represented by overhead views, instead of 3D views, you can
change this by unchecking the uppermost box
in the Preferences menu, called Show 3D View
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in insert dialog. It is possible to create your
own .tif files using one of the many artistic
drawing programs on the market. See the
section on Creating Your Own 3D Library
Symbols for information on creating .tif files
for your own objects.

Polygon Tool
Draws polygons from connected straight lines.
To draw a polygon:
Select a line pattern and a fill pattern. Set line
thickness or style by clicking the appropriate
icon on the line palette, then click the polygon
icon on the tool palette.
Move the cross hairs to the place on the drawing area where you want to begin drawing the
polygon. Press and release the left mouse
button to anchor one end of a flexible line, then
move the mouse. The flexible line stretches
from the anchor point to the mouse position.
Notice that the screen scrolls smoothly if you
try to extend the line off the edge of the current
window.
When you have stretched the line to the length
you want, click the left mouse button again
and the first segment is set. Move the cursor
(don’t drag) and then click for each additional
segment. When you have completed the last
segment, click the right mouse button. The last
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point will automatically connect to the first
point and any fill pattern or color that shows in
the working rectangle will fill the polygon.
You can change existing polygons in two
different ways. You can resize it the same way
you resize other objects, but you can also
adjust the position of its vertices.
To adjust the vertices of an existing polygon,
position the selector tool over the object, hold
down the shift key and click. If the polygon
was not already selected, standard handles will
appear. Shift-click again and handles will
appear at each vertex. (A third Shift-click
makes all handles disappear.) You can drag
each vertex to a new position.

Selector Tool
The selector tool is the arrow-shaped pointer
that is displayed when you’re choosing a
drawing tool, pattern, line thickness, selecting
an object, or using the menus. The selector tool
moves in response to movement of the mouse.
To select the selector, click in the top left corner
of the tool menu. Your cursor should become
an arrow and the arrow on the tool bar should
be highlighted.
To select an object: First, select the selector tool.
Position it over the object you want to select
and click. Four black handles will appear
around the object, indicating that it’s been
selected.
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To select an additional object: Position the
selector tool over the next object you want to
select, hold down the Shift key and click.
To select several objects: Drag a box with the
selector tool that surrounds the objects completely.
To bring up information and properties on an
object or shape double-click with the left
mouse button or right click the mouse button
to bring up the Object Information Dialog box.

Sketch Tool
Draws a freehand object.
To sketch an object: Select a line color. Set line
thickness or style by clicking the appropriate
icon on the line palette, then click the sketch
icon on the tool palette.
Move the cross hairs to where you want to
begin sketching. Press and hold the left mouse
button to drag the cross hairs into a shape.
When the sketch is to your liking, release the
mouse button. Notice that the screen scrolls
smoothly if you try to extend the line off the
edge of the current window.
Note: The sketch tool will not fill with a fill
pattern. You’ll find it useful for signing your
name or writing messages, or sketching custom shapes.
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Stud Tool
Draws a stud object, showing joists or studs,
whose size and orientation are determined by
the settings in the Stud Specifications dialog.
To draw studs:
Adjust the settings in the Stud Specifications
dialog to what you want. Be sure to specify
which tracking option you want: rectangle or
polygon. This changes the way the stud tool
defines the area to be filled with studs. You can
draw using a flexible box (Rectangle option) or
a flexible line (Polygon option).
Select a line color. Set line thickness or style by
clicking the appropriate icon on the line palette, then click the stud icon on the tool palette.
Move the cross hairs to where you want to
begin drawing. Press and hold the left mouse
button to anchor one corner of a flexible box
(or flexible line, if using polygon tracking
option). Drag the cross hairs. The flexible box
(or line) stretches from the anchor point to the
mouse position. Notice that if you drag it off
the side or bottom of the screen, the screen
automatically scrolls to accommodate the size
you want.
When the stud box (or polygon) is the size and
shape you want, release the mouse button (or
click the right mouse button to complete the
polygon).
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To draw a perfectly square box, or to constrain
the lines of the polygon (to horizontal, vertical,
and 45 degree angles), press the Ctrl key while
you drag.
You can use the stud tool to help you draw
decking. Just change the on center distance to
match the board width.

Text Tool
You can type text of any line color with any fill
pattern or color.
To use the text tool: Select a fill pattern (leftclick) as the background, right-click for the text
color, then select the text tool. Next, move the
cross hairs into the drawing area and click
where you want to begin typing. If you make a
mistake while typing, just backspace and press
delete to remove an incorrect letter. You can
highlight several letters to delete or replace
them. (See Editing Existing Text). Use Ctrl +
right and Ctrl + left arrows to jump from word
to word in your text, or just click the cursor
next to the unwanted letter and delete it. You
can also use the Home and End keys.
With the mouse only, if you want to continue
typing but at a different location, move the
pointer to the new location and click. The last
text you typed is kept as an object and you can
begin typing a new text object.
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3D WalkAround lets you easily experiment
with text to get the effect you’re looking for.
Select a text object. Left-click in various locations along the pattern and color palettes to
change the background. Right-click on several
different colors to change the text. Change the
patterns with Ctrl + right-click and Ctrl + left
click.
To type white on a color, left-click red or black
or another dark color and then right-click
white for a nice effect.
To block out your text when you want it to
stand out from the background color of another object, you can use the reverse process
just described or you can select a white fill
(left-click) and a dark text (right-click).
You can manipulate an existing text object with
items from the Text and Edit menus. Options
in the Edit menu operate on selected text
objects just like any other object. First, select
the text object using the selector tool, then
select the item you want from the Edit menu.

Changing Text Styles
You can use bold, italic, underline and
strikeout styles for the text you type. Except for
normal, which cancels all others, the styles are
cumulative. The styles you choose affect all
selected text objects and the text tool.
1. Select a text object.
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2. Go to the Text pull-down menu and select
Bold, Italic, Underline, or Strikeout to change
the text.
3. To cancel any style (except for Normal),
choose the style again. To cancel all current
style selections, choose Normal.
You can also select a style in the Font Dialog
box.

Choosing Fonts and Sizes
Fonts and font sizes affect all selected text
objects and the Text tool.
To choose a font or font size: Choose Font...
from the Text menu. Select a font from the font
box, select a size from the Size box, then click
OK. You can use this option before typing to
set up your text correctly; or you can select one
or more text objects to change. You can also
select a style from the Style box. Try this too
with a selected text object.

Editing Existing Text
To edit existing text, select the text tool, then
click the cursor at the place within the text
object where you want to start editing. A
blinking cursor will appear.
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You can also highlight a part of the text to
delete or replace it. Drag the cursor over the
letters you want to replace. While text is highlighted you can press the delete key to remove
it, or type correct replacement letter(s).

Wall Tool
Draws a thick line, designated as a wall object.
To draw a wall:
Wall
Tool

Select a line color by clicking the right mouse
button on a color on the top row of the color/
pattern palette. Select the wall tool by left
clicking its icon on the tool palette.
Move the cross hairs to the place on the drawing area where you want to begin the wall.
Press and hold the left mouse button to anchor
one end of the line. Drag the cross hairs. A
flexible line stretches from the anchor point to
the mouse position. You will see the measurements of the wall on the right hand end of the
wall as you draw it. Notice that the screen
scrolls smoothly if you try to extend the line off
the edge of the current window.
When the line is the length and orientation you
want, release the mouse button.
To constrain an already existing or new wall,
simply hold down the CTRL key as you edit
and drag one of its handles. This will ensure
that the line is perfectly straight.
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Note: To make it easier to connect the walls of
your house, be sure to use the Automatic Wall
Snap option in the User Preferences dialog
under the Options menu. Choosing this option will automatically "snap" the ends of walls
together. After drawing the first wall, position
the cross hairs close to the end of the first wall
and draw the second wall. The second wall
will automatically be snapped to the end of the
first. You can change the distance setting for
the wall snap by increasing or decreasing the
number of units in the User Preferences dialog.
You can cause an automatic dimension line to
be displayed next to the walls you have drawn.
To do this, select the wall(s) you want to
change, hold down the CTRL key, and left click
the Measuring Tool icon. To hide the dimension lines, simply repeat the procedure.
You can control the side of the wall on which
the dimension line appears and its distance
from the wall by setting the desired values in
the Preferences dialog before drawing the wall.
For more information about dimension lines,
see Dimension Lines.
Setting a wall altitude:
You may assign an altitude to your walls by
right clicking on the wall. This will bring up
the Object Information dialog window.
Clicking on the 3-D info button will call up the
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Wall 3-D Display Info dialog. Here, you can
enter the Wall Height, Wall Altitude, Thickness
in 3-D Viewer, as well as Texture file names for
your walls.

Height of Wall: This value determines how
high your wall is. The height limit for any wall
is 327.67'. While it is possible to stack walls on
top of each other that will exceed this height,
doing so will probably give erroneous results.
The default value of any wall is 8'.
To set the height for a wall with a level top,
enter the value into the box in the 'Whole
Object' column. Entering information for
Points 1 & 2 is not necessary. If you want a
wall height of 8 1/2', enter a value of 8.5. You
don't need to type the apostrophe.
To set the height for a slanted wall top, you
must first determine from the diagram on the
right side of the 3D Info Box which point is
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Point 1 and which is Point 2. Once this has
been established, enter the desired height into
each box under Pt #1 and Pt #2. You do not
need to enter a value in the 'Whole Object' box.
Elevation of Wall: This setting determines the
altitude at which your walls will be displayed.
This feature allows the design of multiple story
structures, split levels, and sunken rooms, as
well as aiding in the construction of 3D objects.
The default elevation for any wall is 0'.
To set the altitude for a wall with a level bottom, enter the value into the box in the 'Whole
Object' column. Entering the information for
Points 1 & 2 in not necessary.
To set the elevation for a slanted wall bottom,
enter the values in the boxes under Pt #1 & Pt
#2, as you would for the height of the wall
(above). It is not necessary to enter a value for
the Whole Object. Note that the wall top will
also be slanted unless you change the Wall
Height to compensate for the slanted bottom.
Thickness In 3-D Viewer: This setting allows
you to adjust the thickness of the wall in the 3D viewer. The default value is 5”. If you want
1’ thick walls, you would enter a value of 1’, or
12". If you wish to enter the number in feet,
you must type in the ' symbol after the number,
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Texture scaling: Changing the Texture Scale
setting allows you to modify the scale at which
textures appear in the 3D window. The default
setting for any texture is 100. At this scale the
texture will appear on the object unchanged. If
the number is raised above 100, the texture
will be stretched out in proportion to the increase. Likewise, lowering the Texture Scale
amount below 100 will scrunch the texture in
proportion to the decrease. Any value from 0
to 9999 may be used.

Floor/Ceiling Tool

Floor/
Ceiling
Tool

The Floor Tool allows you to draw polygons
that represent floors or ceilings which will
automatically appear in the 3-D view. This
tool also allows for the design of multiple story
structures, split levels, sunken rooms, and
simple 3-D object creation such as cabinets,
tables, counters, etc...
To draw a floor, you will most likely want to
trace a room’s walls. After selecting the floor
tool, your pointer will turn into a cross hair.
Place the cross hair at the point where you
want to start your floor and left click once.
Move to the first line’s end point (and the next
line’s start) and left click again. Continue this
sequence until you’ve completed the floor
object by ending at your original start point
and right clicking. Once back at your starting
point, right click to finish the floor.
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Once the floor is drawn, it is automatically
moved below walls and other objects in the
2-D window. This ensures that it will not
cover anything else that you have drawn. You
may now edit the floor patterns and colors just
like with any other polygon. You may also
edit the shape of the floor by left clicking the
floor object, then holding the Shift key down,
pausing for a second, and left clicking it again.
If it is an irregular shaped polygon, you will
notice that the handles now appear at every
point of the polygon instead of just the four
corners. Once you have done this, you may
grab any of the points and alter the shape of
the polygon.
Note: After you have drawn a floor object, the
default floor will disappear. If you delete the
floor that you just drew, the default floor will
return. If you have a full floor plan with many
rooms but only want to change the floor in one
of them, it is best to draw a new floor that will
fit the entire area of the plan.
You may also change the default texture on
any floor object, including the default floor.
Changing the default floor texture:
In the 2-D window, select Options followed by
Preferences. Click on the button to the right of
the Floor texture file window. This will bring
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up the texture viewer. Select the texture that
you wish to apply to your default floor. This
texture will stay in effect until you change it.
Changing drawn floor object textures and
attributes:
Select the floor object whose texture you want
to change by right-clicking on it. In the Object
Information window, click on the 3D Info
button. This will bring up a dialogue box called
3D Floor Parameters, which will give you the
following options.
Texture File Names: This field lets you select
textures for your floor or ceiling. The Top Side
will change the top and sides of your floor. The
Bottom setting will change the underside of
your floor object.
Altitude: Use this field to change the altitude
of your entire floor, or one or more points. To
change the altitude of the entire floor, enter a
new value in the field in the 'Floor' Row. To
change the altitude of a single point, first select
which point you want to change by using the
arrows to the left of the diagram of the currently selected point. Once you have selected
the point that you want to change, set the
altitude to the desired height. Once you are
back in the 3D view, the floor will change to
the specifications you've set. If you set two
adjacent floor points to different heights, the
floor will slope between the two points.

74

Chapter 3, Tools

Thickness: This will allow you to change the
thickness of your entire floor, or you can adjust
the thickness at one or more points. This is
done in the same way as adjusting the altitude.
Texture Scale: Changing the Texture Scale
setting allows you to modify the scale at which
texture appear in the 3D window. The default
setting for any texture is 100. At this scale the
texture will appear on the object unchanged. If
the number is raised above 100, the texture will
be stretched out in proportion to the increase.
Likewise, lowering the Texture Scale amount
below 100 will scrunch the texture in proportion to the decrease. Any value from 0 to 9999
may be used.

3D WalkAround View Button
Click the 3D button to open a 3D window for
the active 2D design window Once the 3D
window is open, you may resize it to whatever
size you wish. You may have both a 2D and a
3D window open at the same time and arrange
them together side by side. To have the 3D
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window update itself whenever you make a
change in the 2D window, select 3D from the
menu and select Automatic Update. Whenever
it is active, you will see a check mark next to it.

3D Window Buttons
Bird’s-Eye View Button
Click this button to change from a walkaround side view to a 3D overhead bird’s-eye
view of the 2D design.
Walk-Around Side View Buttons
Click these camera buttons to see one of four
3D side views, or re-center a side view.
Light Intensity Buttons
Clicking the middle button here will turn the
lighting effects on and off. You may increase
or decrease the lighting intensity by clicking on
the buttons with the up and down arrows.
Texture Buttons
Use these buttons to specify whether to apply
textures to the 3D view. The leftmost button
will toggle between textures and flat-shaded
objects. Turning textures off will speed up
your walk-around speed. The middle button is
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the Coarser but Faster setting. This setting will
lessen the detail in the 3D window allowing for
faster movement. The rightmost button will
put you in wireframe mode. This turns off all
textures and shading and will greatly increase
movement speed. You may also select Coarser
but Faster while in wireframe mode for an even
greater increase in speed.
You may also access any of these functions by
clicking on Options in the 3D window and
choosing them from there.
Movement Buttons
Movement in the 3D window can be accomplished in more than one manner. Perhaps the
easiest way to navigate throughout the 3D
window is with the movement buttons.
Raise and lower the viewer altitude
Moves view forward and backward
Sidesteps left and right
Turn left and right
Look up and down
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Navigating with the mouse
You may also navigate by using your mouse
pointer in the 3D window. Think of the 3D
window as a clock face. As you move the
pointer up towards 12 o’clock and hold down
the left mouse button, you will move forward.
Move it down towards 6 o’clock and you will
move backwards. Likewise, moving the
pointer to the 3 o’clock position will cause you
to turn towards the right, while the 9 o’clock
position will turn you to the left. Anywhere in
between these positions will move you in that
direction. If you wish to side step, hold down
the shift key while placing the pointer at the 9
or 3 o’clock positions.
Navigation via the keyboard
You may also use your keyboard to move
about in 3D by pressing the cursor arrow keys.
The up and down arrows will cause forward
and backward movement and the left and right
arrows will cause you to turn in those respective directions. To sidestep using the keyboard, hold down the shift key while pressing
the left and right keys. The Page up and Page
Down keys will raise and lower the camera.
To look up or down, hold down the CTRL key
while pressing the up or down arrow keys.
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Essential features of 3D WalkAround are found
in the menus across the top of the window.
Some menu options have an ellipsis following
the them (e.g., Font...). When you select a menu
item with an ellipsis, a new window with
special options or instructions appears (a
dialog box). Some menu options have an arrow
next to them, indicating that option has a
submenu. Sometimes a menu option is
dimmed (shown in gray text instead of black)
and you cannot select it. This usually means
you need to do something else first.

Keyboard Shortcuts
A keyboard shortcut is a combination of keys
that you can press to carry out a particular
command. Keyboard shortcuts are listed to the
right of the menu options in each pull-down
menu. Do not press the + sign. Just press the
two indicated keys. Notice that not all menu
options have a shortcut key. You’ll find that
after you have become familiar with 3D
WalkAround, using shortcuts will come naturally and will speed up program operation.
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File Menu

New
Opens a new drawing window and assigns it
the name “Untitled”. Whenever you start 3D
WalkAround, it starts with the file “Untitled.”
To start a new file: Choose New from the File
menu. If you have made changes to the current
file, a dialog box appears telling you that your
file has changed and asks if you want to save it
before closing that window and opening a new
one. If you change your mind and don’t want
to close the current drawing, click Cancel. If
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you don’t want to save the file, click No. The
drawing is removed from the screen and a
new, “Untitled” window is opened.
If the file already has a name it is automatically
saved if you click OK. It’s then removed from
the screen, and a new, “Untitled” window is
opened. If the file’s name is “Untitled” and you
click OK, the Save As dialog appears.
Keyboard shortcut - Ctrl+N

Open
This option brings an existing 3D WalkAround
file from the disk to the drawing window.
To open an existing file: Select Open from the
File menu. If you have made any changes to
the current file, a dialog box appears, asking
whether you want to save those changes before
opening a different file. If you change your
mind and don’t want to close the current
drawing, click Cancel. If you don’t want to
save the file, click No. The drawing is removed
from the screen and then the Open Drawing
dialog box appears. If the file already has a
name, it is automatically saved when you click
OK. It’s removed from the screen, and the
Open Drawing dialog box appears. To save the
file, click Yes. If the drawing name is “Untitled,” the Save As dialog box appears.
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Your file is saved to disk, removed from the
screen, and the Open Drawing dialog box
appears.
The Open Drawing dialog box displays the
names of all files in the current directory that
have the extension *.yoh. To display all files in
the current directory, select All Files from the
List Files of Type box. Change directories and
disk drives by clicking in the appropriate
boxes. When you have found the file you want
to open, double-click the file name, or click the
file name and then click OK.
Keyboard shortcut - Ctrl+O

Open Old Versions
If you have upgraded to a new version of 3D
Walkaround, and you want to open one of the
layouts you created with the older version,
choose this option to open the desired layout.
You will probably have to locate the old layout
in a different folder, depending on where you
saved it. Upon opening the layout, save it so
that it will be recognized as a new version.

Save
Saves the current drawing to a disk file.
To save a file: Choose Save from the File menu.
If the drawing name is “Untitled,” the Save As
dialog box appears. To save to a different
drive, select the drive you want from the
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Drives box. To save the file in a different directory, double-click the directory in which you
want to save the file. Click on a file name in the
File Name box if you want to write over an
existing file on disk. For a new file, type a name
in the File Name box, then click OK. File names
are limited to 8 characters, followed by a 3letter extension. An example of a file name is
MYDRAWNG.YOH. You do not need to type
the .YOH extension. The program will automatically add it to your file name.
If you have already named the drawing, the file
is automatically saved without any confirmation or dialog.
Save replaces any previous version, use Save
As to give the file a different name.
Keyboard shortcut - Ctrl+S

Save As
Selecting Save As brings up the Save As dialog
box, allowing you to name a new drawing,
rename the one currently open, or overwrite the
current drawing to one already on disk.
The Save As dialog also appears whenever you
tell the program you want to Save and the
current file name is “Untitled.” When the dialog appears you can select options to save files
to any drive by clicking the drive you want in
the Drives box. To save to a different directory,
double-click the directory where you want to
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save the file. Type a name for the file in the
File Name box, then click OK. If you want to
overwrite an existing file, you can click on a
gray name in the File Name box and it will
appear in the entry box. File names are limited
to 8 characters, followed by a 3-letter extension. An example of a file name is
MYDRAWNG.YOH.
Note: You need only type the first 8 characters
of a file name. The .YOH extension will be
added to it automatically.
When you click OK, the file saves to disk. And
depending on where you were before the Save
As dialog appeared, different things will
happen after the Save. If you have selected
New, after the save the file is removed from
the screen, and a new, “Untitled” window is
opened. If you’ve selected Open, after the save
the Open dialog appears. If you’ve selected
Exit, the file is saved and the program closes.
If you’ve selected Save As, you return to your
current drawing.

Export
This menu option allows you to export all
objects or selected objects. You can export
objects in several file formats for use in other
programs. The formats include: Windows
Bitmap (BMP), QuickDraw PICT (PCT), PC
Paintbrush (PCX), Multipage PCX (DCX), and
Windows Metafile (WMF).
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To save all objects or selected objects in your
drawing, in the File menu select Export. First
select the File Type from the list of formats.
Then type a file name in the file name box.
Select the directory and drive where you want
to save the file and click OK.

Export to Design Estimator
This option creates files compatible with the
Design Estimator, a powerful estimating program available from Abracadata that will
attach prices to objects, enabling you to estimate the total cost of your project.
Nothing visible will happen on screen, but this
option will create a file with the same name as
your drawing, with the extension CSV.

Print
This option prints the current drawing on a
printer device you have set up in Windows.
The Print Drawing dialog box appears. You’ll
see your current printer listed on the upper
left. Beneath that, you’ll see a small image of
your drawing, covered with one or more gray
page outlines. Click on the pages to turn the
outlines off and on to select the page(s) you
want to print. From the keyboard, you can
TAB over to the image, move from page to
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page with the arrow keys, and use the space
bar to select and unselect the pages you want
to print.
In this dialog you can also select an alternative
printer quality configuration. The possible
choices depend printer. You can also choose
Print to File. If you select this, you’ll get an
additional dialog requesting file name and
directory information. You can also tell the
printer to Collate Copies. This means, if you
have several pages and you’ve requested more
than one copy, the printer will print them in
sequential groups rather than in groups of
numbered pages.
Click OK to start printing. Make sure your
printer is turned on and on-line.
To check or change the paper size and other
settings for your printer, click the Setup button.
The Print Setup dialog box appears.
To interrupt the printing process, click Cancel
or press Enter while the Cancel dialog is on the
screen.
Keyboard Shortcut - Ctrl+P

Printer Setup
This option brings up the Print Setup dialog
box, allowing you to select a printer and set
printer options before printing. The options
available depend on the printer you select. This
option and the one in the Print dialog connect
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you to the Windows Setup options which may
be familiar to you already. Consult your Windows documentation if you need detailed
information on setting up your printer.

Printing with a Laser or Ink Jet Printer
Laser printers and Ink Jet printers have “unprintable regions” around the edge of the page.
Typically the unprintable region is between 1/
8 & 1/4 of an inch. Each individual printer has
its own alignment characteristics which can
affect these unprintable regions. Therefore, if
you are trying to center a drawing on a page
for one of these printers, it may require some
experimentation on your part to determine
what type of margins you need to give your
drawing in order to center it on a page.
We suggest using the default page size shown
in the drawing layout dialog. The page size
that you see in the drawing layout dialog
indicates the maximum printable area for your
currently selected default printer for the current paper size. Then make sure to leave 1/8"
to 1/4" margins around the drawing. Once
your drawing is finished, you can group the
whole drawing and move it up, down, right, or
left to center it with respect to your individual
printer.
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Exit
Closes the file you have been working on and
quits 3D WalkAround. If you have made any
changes to the current file, this item asks
whether you want to save those changes before
quitting. If you select yes and your drawing
already has a title, it will be saved and you will
exit the program. If your drawing does not
have a name you will go to the Save As Dialog
to enter a name.
Keyboard Shortcut - Alt+F4

Edit Menu

Undo
Reverses the last change made to a drawing.
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To undo your last action, select Undo from the
Edit menu. You can undo many changes in
your drawing. The number of undos available
to you depends on available computer
memory. It is not unusual to be able to undo 10
changes, and in some cases, you may be able to
undo hundreds of changes. Redo allows you to
change your mind again.
Caution: Although 3D WalkAround can remember more than your last change, it is good
practice to Undo a change right away if you
don’t want to keep the change.
Keyboard shortcut - Alt+Backspace

Redo
Undo lets you reverse the last change made to
your drawing; Redo allows you to change your
mind again. You can redo as many undos as
you have done.
Keyboard shortcut - Alt+Shift+Backspace

Flush Undo
This menu command clears your computer’s
memory of all the Undo and Redo information.
It is particularly useful if you have performed
an undo or redo on a bit map. Bit maps use up
a great deal of memory, so you’ll get better
performance from this application as well as
other Windows applications if you flush the
buffer periodically.
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To flush the buffer, simply select this menu
item. You’ll notice that the Undo and Redo
commands become gray.

Cut
Removes all selected objects from the current
window and moves them to the clipboard. This
is the same clipboard shared by other Windows applications, so you can use this option
to export objects or groups of objects into other
programs or into another open 3D
WalkAround window.
To Cut one or more objects:
Select one or more objects that you want to
remove, then choose Cut from the Edit menu.
All selected objects are removed from your
drawing and moved to the clipboard.
Keyboard shortcut - Shift+Delete

Copy
Copies all selected objects to the clipboard
without removing them from your drawing.
To copy objects: Select the objects that you
want to copy, then choose Copy from the Edit
menu. A copy of all selected objects is placed
on the clipboard. Your original stays on the
screen.
Keyboard shortcut - Ctrl+Insert
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Paste
Places a copy of the clipboard’s contents in the
current window. This object can be something
you just cut or copied to the clipboard, or it
might be an object from another application.
To paste the clipboard’s contents into the current drawing: Choose Paste from the Edit
menu. A copy of the clipboard’s contents appears in the drawing.
You can use Copy and Paste together to copy
objects from one drawing into a different drawing or from one Windows application into
another. Copy the object(s) to the clipboard,
then open another drawing or application and
paste the object(s) into it. You can perform
dozens of Pastes after one Copy or Cut. So use
this option if you need to duplicate an object
many times.
Keyboard shortcut - Shift+Insert

Delete
Removes all selected objects from the current
window, but does not move them to the clipboard. Use delete to permanently remove an
object from the drawing.
To remove objects from the current drawing:
Select the objects you want to remove, then
choose Delete from the Edit menu, press the
Delete key, or press Ctrl+Delete.
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Keyboard shortcut - Delete key or Ctrl+Delete

Duplicate
You can perform the equivalent of a copy and
paste in one operation by using the Duplicate
option.
To duplicate objects: Select the objects that you
want to duplicate, then choose Duplicate from
the Edit menu. A copy of all selected objects is
placed on the clipboard, your original stays on
the screen, and a copy of the selected objects
appears in the drawing.
Keyboard shortcut - Ctrl+D

Select All
This option selects every object in the current
drawing. Every object will have handles. You
can then perform any of the Edit menu operations on all of the objects at once, provided
none of the objects are locked. (See “Lock”
under the Arrange Menu). You can stretch all
objects, change colors, line sizes, line pattern
and fill pattern. This command can also be
handy if you want to move your whole drawing to a different screen location.
Keyboard shortcut - Ctrl+A
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Repaint
Repaint redraws the 3D WalkAround screen.
Select Repaint when you see parts of objects or
other items on the screen that shouldn’t be
there. This sometimes happens after rotating
or dragging certain types of objects or text, or
under certain scrolling conditions.
Keyboard shortcut - Ctrl+P

Arrange Menu

Bring to Front
Places selected objects in front of any objects
that overlap them.
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Select one or more objects that are behind
other objects. Choose Arrange: Bring to Front
to bring the objects to the front of the drawing.
Keyboard shortcut - Ctrl+F

Send to Back
Places selected objects behind any objects that
they overlap.
Select one or more objects that are in front of
other objects. Choose Arrange: Send to Back
to send the objects to the back of the drawing.
Keyboard shortcut - Ctrl+B

Rotate Left
Rotates selected objects 90 degrees to the left.
Select the objects you want to rotate, then
choose Rotate Left from the Arrange menu.
Keyboard shortcut - Ctrl+L

Rotate Right
Rotates selected objects 90 degrees to the right.
Select the object(s) you want to rotate, then
choose Rotate Right from the Arrange menu.
Keyboard shortcut - Ctrl+R
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Rotate Left 1 Degree(s)
Rotates selected objects a given number of
degrees to the left. To set the number of degrees, see Preferences under the Options menu.
Select the object(s) you want to rotate, then
select Rotate Left 1 Degree(s) from the Arrange
menu.
Keyboard shortcut - Ctrl+1

Rotate Right 1 Degree(s)
Rotates selected objects a given number of
degrees to the right. To set the number of
degrees, see Preferences under the Options
menu. Select the objects you want to rotate,
then choose Rotate Right 1 Degree(s) from the
Arrange menu.
Keyboard shortcut - Ctrl+2.

Restrictions on Rotation
Note: Some objects, such as bitmaps, cannot be
rotated. If you select a non-rotatable object, the
rotation options on the Arrange menu will be
gray, indicating that the options are not available for that object. If you rotate a non-rotatable object as part of a group, the object will
move to maintain its position within the group,
but the object itself will not rotate.
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Flip Horizontal
Flips selected objects from side to side. (Note
that some objects, such as charts and text,
cannot be flipped.) Select the object(s) you
want to flip horizontally, then choose Flip
Horizontal from the Arrange menu.
Keyboard shortcut - Ctrl+H

Flip Vertical
Flips selected objects from top to bottom.
(Note that flipping certain types of objects,
such as stairs, may give unpredictable results
in the 3D Window.) Select the objects you
want to flip vertically, then choose Flip Vertical
from the Arrange menu.
Keyboard shortcut - Ctrl+I.

Restrictions on Flipping
Note: Some objects, such as text objects, cannot
be flipped. If you select a non-flippable object,
the flipping options on the Arrange menu will
be gray, indicating that the options are not
available for that object. If you flip a nonflippable object as part of a group, the object
will move to maintain its position within the
group, but the object itself will not flip.
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Group
Converts 2 or more selected objects to a single
grouped unit. Any changes made to the
grouped unit will affect all the component
objects.
Select the object(s) you want in the group.
Choose Group from the Arrange menu,
or press Ctrl+G.
Keyboard shortcut - Ctrl+G

Ungroup
Separates a grouped unit into its individual
component objects.
Select a grouped object and choose Ungroup
from the arrange menu, or press Ctrl+U.
Keyboard shortcut - Ctrl+U

Lock
Prevents selected object(s) from being changed,
moved, grouped, ungrouped, or deleted.
Select the object(s) you want locked and choose
Lock from the Arrange menu (or press Ctrl+K).
A locked object will have hollow handles when
you select it.
Keyboard shortcut - Ctrl+K
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Unlock
Unlocks selected locked objects, enabling you
to move and rotate them, change their colors,
etc.
Select the objects you want to unlock and
choose Unlock from the arrange menu.
Keyboard shortcut - Ctrl+J.

Text Menu

The text menu allows you to set the size, style,
font, and alignment of text objects. You can
make changes to styles, sizes and fonts from
the Font dialog box and you can make style
and alignment changes directly from the Text
menu. Note: You cannot change the size, style,
or font of only a portion of a text object. If you
need a font, style, or size change in the middle
of a phrase or paragraph, simply complete the
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text before the change. Make the appropriate
change in the Font dialog and start a new text
object right next to the first text object. You can
continue to alternate between styles, fonts, and
sizes if you need to.

The Font Dialog
When you select Font... the Select Font dialog
pops up. The font, size, and style you choose in
this dialog affect all selected text objects and
the text tool. With the option you can set a
default for the size you want your text to start
out with. If you change Fonts, Styles, or Sizes,
they’ll stay that way until you change them.
To choose a font, size, or style: Choose Font...
from the Text menu. Select the font you want
from the Select Font box, select a size from the
Size box. You can also select a Style if you want
to set a particular default style. Click OK. The
next text you type will be according to the
specifications you set. If you have some text
selected while you change the options in the
Select Font box the selected text will take on
the new settings.

Normal Text Style
The normal text style cancels all current style
selections. The font selection and the size
remain the same.
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Bold Text Style
Boldface letters are slightly larger than normal
and they appear thicker. Click Bold on the Text
menu to embolden a selected text object and to
affect the Text tool.
When the Bold menu item is chosen, a check
mark appears by it to show it is in use. To turn
Bold typing off, click on the menu item again,
or click on Normal.

Italic Text Style
An italicized word consists of letters leaning
slightly to the right. Italics are often used to
show emphasis on a word or idea.
Click Italic in the Text menu to initialize a
selected text object and to affect the Text tool.
When the Italic menu item is chosen, a check
mark appears by it to show it is in use. To turn
italic typing off, click on the menu item again,
or click on Normal.

Underline
Choosing the Underline option from the Text
menu causes text to be underscored. Click
Underline to underline selected text and to
affect the Text tool.
When the Underline option is chosen, a check
mark appears by it to indicate it is in use. To
turn underline typing off, click on the menu
item again, or click on Normal.
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Strikeout
The Strikeout item on the text pull down menu
allows you to type text with a solid line crossing all of the letters.
Click Strikeout to affect a text object and to
affect the Text tool.
When the Strikeout option is chosen, a check
mark appears by it to indicate it is in use. To
turn off the Strikeout option, click on the menu
item again, or click on Normal.

Left Justify
To Left Justify selected text and to affect the
Text tool, click Left on the Text menu.

Centered
To Center a block of text and affect the Text
tool, click Center on the Text menu.

Right Justify
To Right Justify a block of text and to affect the
text tool, click Right on the Text menu.
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Layout Menu

Drawing Size
This option lets you change the size your
drawing. The size will always be a whole
number of pages, based on the paper size and
orientation you have chosen for your printer.
The numbers that appear in the Width and
Height boxes tell you the total printable area of
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the drawing. (Depending on the type of
printer, the printable area of a page is often less
than the full size of the page.)
The Drawing Size dialog also allows you to
select the units of measure you want to use:
inches, centimeters, or millimeters. To change
the units of measure, click the button for the
unit system you want to use. If you have Show
Rulers selected, the rulers will change to the
selected units when you close the Drawing Size
dialog.
To change the drawing size or units of measure: Choose Drawing Size from the Layout
menu. Use the arrow keys or the arrow buttons
on the Width and Height boxes to change the
number of pages in the drawing. Use the lists
of available printers and paper sizes at the
bottom of the dialog to determine the size of
each page. Use the Units buttons to change
between English units (inches/feet) and metric
units.

Drawing Scale
There is an unlimited number of scale choices
available for each unit of measurement (inches,
centimeters, millimeters); however, four of the
most commonly used scale choices are provided as dialog options. To set a custom scale,
click the up and down arrows next to the units
you want to change.
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The default scale when you first start 3D
WalkAround is 1/2 inch = 1 foot (1/2 inch on
the screen represents 1 foot in the real world).
Ruler units indicate the on-screen measurement; logical units indicate the real-world
measurement.
Each scale change increases or decreases the
drawing’s real-world width and height. For
example, if you choose 1/8 inch = 1 foot, the
drawing’s real-world width increases to 64
feet, and the height increases to 88 feet.
Do some planning before choosing or changing
a scale. Although 3D WalkAround can rescale
existing objects when you change scales, it’s
much better to choose the correct scale before
you begin drawing and stay with that scale.
If you decide to use a custom scale, we suggest
that you choose a number for the logical unit
that is divisible by 12 (if you’re using English
scale) or by 10 (if you’re using metric).

Show Rulers
This option displays or removes the on-screen
rulers. A check mark next to this option indicates that it is in effect. Rulers are handy for
more accurate drawing layouts and when you
want to draw a specific sized object. Ruler
measurements are set according to the Ruler
Type you have selected in the Drawing Size
dialog. They can be English-Inches, MetricCentimeters, or Metric-Millimeters.
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Ruler Type
3D WalkAround allows you to select an appropriate unit of measure for your ruler. Valid
selections are inches, millimeters, or centimeters.
To change the unit of measure, click one of the
ruler type options from the Drawing Size
dialog box located in the Layout Menu. The
drawing width and height will change to
reflect the selected measurements. If you have
Show Rulers selected, the rulers on your drawing will reflect the selected units.

Show Ruler Lines
This option displays or removes the on-screen
rulers. A check mark next to this option indicates that it is in effect. Rulers are handy for
more accurate drawing layouts and when you
want to draw a specific sized object. Ruler
measurements are set according to the Ruler
Type you have selected in the Drawing Size
dialog. They can be English-Inches, MetricCentimeters, or Metric-Millimeters.

Show Page Breaks
This menu option lets you show or hide page
breaks. Page breaks appear as light gray lines
across your drawing area. These lines are for
reference only and will not print.
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When you first enter the Mighty Draw program, the drawing size is automatically set to
the maximum printable region for one sheet of
paper based on the paper specified for your
currently set default printer. If you increase
your drawing size beyond that set by the
default printer, Mighty Draw will break up
your drawing area into separate pages. Choosing the Show Page Breaks option causes the
outlines of each page to display.
To learn how to change your drawing size, see
the Drawing Size command under the Layout
menu.
When the Show Page Breaks option is chosen,
a check mark appears by it to indicate it is in
use. To turn off the page breaks, click on the
menu item again.

Show Status Bar
The status bar is the gray bar that runs along
the bottom of the drawing window. It displays
information about the currently selected object,
or the number of selected objects if more than
one object is selected. Depending on the object,
you might see what type it is, or other pertinent information.
Click on the Show Status Bar option to display
or hide the status bar. A check mark next to
this option indicates that the status bar will
display. Click on an object to see its information.
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Create Camera
Selecting this option from the Layout menu
will place a camera in the center of the 2D
view. The camera is used to direct the 3D view.
The camera object is represented by two boxes.
The smaller box is the aiming box. Moving this
box around will allow you to change the focal
point of your 3D view, which is useful if you
want to pan right and left to see different views
through one point. The larger box is the main
camera. Click on the black dot in the center of
the main camera, and you can change your
view while maintaining your focal point. If you
grab the outside of the main camera, you can
move both boxes at the same time, thus changing your focal point and view point simultaneously.
Creating a camera with a 3D Window already
open will place the camera in the 2D Window,
but you'll have to click on it to activate it. If
you place a camera with no 3D Window open,
when you do open a 3D Window, the camera
will activate. Multiple cameras can be created
and shown in the 2D view simultaneously.

Hide Camera
Selecting this option will cause all cameras
present in the 2D Window to disappear. Any
selected camera will still be present and function normally. Deselecting this option will
bring the cameras back into view. Most of the
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time, you will want to see your cameras, but
you may want to hide them when printing, for
instance.

Show Grid
This menu option lets you show or hide grid
points, a handy drawing aid. If Snap to Grid is
enabled, any object you draw or resize will
automatically be snapped to the nearest grid
points, using the coordinates of the object’s
upper left corner. To align an existing object to
the grid, hold down the Ctrl key and move the
object.
If you want to align an existing hollow line to
the grid, move the cursor very slowly, or the
hollow line may “jump” across the screen.
When the Show Grid option is chosen, a check
mark appears by it to indicate it is in use. To
turn off the grid points, click on the menu item
again.
Use the Layout menu option Grid Spacing to
set the spacing of the grid points.

Snap to Grid
When grid snap is enabled, any object you
draw or resize will automatically be snapped
to the nearest grid points, using the coordinates of the object’s upper left corner.
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When the Snap to Grid option is chosen, a
check mark appears by it to indicate it is in use.
To turn off the grid snap, click on the menu
item again.
Use the Layout menu option Grid Spacing to
set the spacing of the grid points.

Grid Spacing
This menu option allows you to set the spacing
of the grid points. The grid points are the little
dots that appear on the screen, spaced at regular intervals. For each scale, there is a minimum and maximum number of inches (centimeters, millimeters) at which the grid points
can be spaced. Both the vertical and horizontal
spacing can be changed.
To change the grid spacing, press and hold the
left mouse button on the up arrow (to increase
the amount of space between grid points) or
the down arrow (to decrease the amount of
space).

Zoom
Use the zoom feature to get a close-up view of
your drawing. You can draw and edit just as
you normally do on the full screen. You’ll find
that the easiest way to use it is with its keyboard shortcut — Ctrl+Z. Each press of the
keyboard shortcut changes the magnification
of your drawing by 10%.
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Unzoom
Use the unzoom feature to get a distant view of
your drawing . You can draw and edit just as
you normally do on the full screen. You’ll find
that the easiest way to use it is with its keyboard shortcut — Ctrl+Y.
Each press of the keyboard shortcut changes
the magnification of your drawing by 10%. By
unzooming a number of times, you can see the
layout of your entire composition.

Whole Drawing
The Whole Drawing command zooms your
drawing out so that you can see the whole
drawing on the screen at the same time. You
can draw and edit just as you normally do at
other levels of magnification. The keyboard
shortcut is Ctrl+W.

Restore
Restore resizes your screen to its standard
default. This is handy to use after zooming or
unzooming to return to the original drawing
size.

Layer
This menu option allows you to create a layer,
remove a layer, or view the base (union of all
layers) of a drawing. Layered drawings are
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useful for showing different floors of a house,
electrical schematics, and even plumbing
diagrams. The default setting for this option is
Base layer.
To create a layer: Click the plus (+) sign in the
upper left corner of the window, above the
“working rectangle” at the left end of the
pattern palette or choose the Create Layer
menu item. The Create Layer dialog appears.
You can choose to have a layer appear
“grayed” when you’re drawing on another
layer by clicking the box next to Show Outline
when Inactive. If at any time you want to
change this setting, double-click on the layer
button number to bring the Create Layer dialog back onto the screen.
To remove a layer: Click the minus (-) sign in
the upper left corner of the window, or choose
the Remove Layer menu item.
When you remove a layer, its objects will
remain in the base layer. To remove the objects,
you need to delete them.
To view the base: Click the “Base” button in
the upper left corner of the window, or choose
the Base menu item in the Layer submenu
under the Layout menu.
If you draw objects on the Base layer and want
to move them to another layer, select all the
objects you want to move, then choose Cut
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from the Edit menu. Create a new layer, then
choose Paste from the Edit menu to bring the
objects onto the layer.

Options Menu

To receive more information on the Options
menu or one of its menu options, refer to the
on-line help file (press F1 while the menu item
is highlighted).

Edit Fill Pattern
This menu option provides you with a utility
to add patterns to the pattern palette. You can
have a custom pattern (and color palette) for
each drawing.
Or, if you wish to set up a set of default patterns for all drawings, simply edit or add
patterns) and then save a one-object drawing
as “default” or “mypalett.” Then, when you
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start a new drawing, open “default” or
“mypalett” to access all your custom patterns.
Delete the one object and start a new drawing.
Be sure to use Save As when you save that
drawing the first time so that you don’t overwrite your default drawing. For details on
how to edit patterns, see Creating New Patterns.

Edit Color
This menu option provides you with a utility
to add colors to the color palette. You can have
a custom color palette (and custom pattern
palette) for each drawing.
You can save the new palette by using the
Save/Load Color Palette menu option.
For details on how to edit colors, see Creating
New Colors.

Save/Load Color Palette
This menu option allows you to save or load a
custom color palette.
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To save a color palette: Choose the Save Color
Palette menu option from the Options menu.
The Save Color Palette dialog appears.
To save to a different drive, select the drive
you want from the Drives box. To save the file
in a different directory, double-click the directory in which you want to save the file. Click
on a file name in the File Name box if you want
to write over an existing file on disk. For a new
file, type a name in the File Name box, then
click OK. File names are limited to 8 characters,
followed by a 3-letter extension. An example of
a file name is MYPALETT.PAL. You do not
need to type the .PAL extension. The program
will automatically add it to your file name.
To load a color palette: Choose the Load Color
Palette menu option from the Options menu.
The Load Color Palette dialog appears.
This dialog box displays the names of all files
in the current directory that have the extension
*.pal. To display all files in the current directory, select All Files from the List Files of Type
box. Change directories and disk drives by
clicking in the appropriate boxes. When you
have found the file you want to open, doubleclick the file name, or click the file name and
then click OK.
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Preferences
This dialog lets you set the rotation factor,
drag handle size, set hollow line thickness,
choose to display object dimensions while
drawing, use “smooth drawing”, and set
automatic wall snap.
Degrees per Rotation: Lets you specify the
number of degrees of rotation for the Arrange
menu options Rotate Left 1 degree(s) and
Rotate Right 1 degree(s). There is a limit of 90
degrees.
Drag Handle size: Lets you specify the size of
the drag handles that appear on objects you
have selected.
Hollow Line Thickness: You can change the
width setting for the hollow-line tool by increasing or decreasing the number of units.
(Each unit is 1/300 of an inch, no matter which
scale you’re in.) Changing the number of units
will not affect existing hollow line objects.
Show 3D View in insert dialog: This option
allows you to set whether library objects are
represented by overhead or 3D views. In version 3.0 (or later) of 3D Walkaround, the default setting shows library objects represented
by .tif files, giving the objects a 3D appearance.
If you desire to see the objects represented by
overhead views instead of 3D views, you can
change this by unchecking this box.
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Smooth Drawing: This option eliminates the
“flicker” as you move objects around the
drawing.
Show Dimensions When Drawing: This item
allows you to show or hide object size measurements that appear when you draw or
resize an object. Object dimensions are displayed in the working unit of measurement
(English or metric). To change the working
unit, see Drawing Size under the Layout menu.
Snap Wall Ends: When you’re drawing the
walls of your house using the wall tool, this
item (when in effect) automatically snaps the
ends of walls together, making it easier to
draw. After drawing the first wall, position the
cross hairs close to the end of the first wall and
draw the second wall. The second wall will
automatically be snapped to the end of the
first. A check mark next to this item indicates
that it is in effect.

Wall Tool Options
Smart Walls: Checking this option sets the
wall drawing tool to draw with a thick double
line instead of a single line. When wall pieces
are joined at any point, the walls will appear to
meld together so that the overlapping lines will
disappear, thus creating a more appealing
appearance.
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Put Dimension Line: This item lets you change
the display option for automatic dimension
lines associated with wall objects (see Measuring Tool). You must select your preference for
this item before drawing wall objects. Once a
wall has been drawn, you cannot change the
location in which the dimension lines will
appear.
If you click the diamond next to Below/Left,
dimension lines will appear below horizontal
walls and to the left of vertical walls.
If you click the diamond next to Above/Right,
dimension lines will appear above horizontal
walls and to the right of vertical walls.
Wall Snap Distance (Dist:): This item lets you
adjust the distance for automatic wall snap.
(See above.) You can change the snap distance
by increasing or decreasing the number of
inches.

Floor Texture File
This option allows you to change the texture of
the floor. The floor texture files are located in
the data directory or pick a floor texture from
the texture book. In this space type the name
of the floor texture you want (i.e. floor001,
floor002, etc...) . Either hit the enter key or
click OK. If you have entered a valid file name,
you will see the floor in the 3D viewer change
to the one you selected.
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Object Information
The Object Information dialog displays detailed information about an object. You can
open the dialog in two ways:
— Right-click or double-click on an object,
or
— Select an object and choose Object Information from the Options menu. If more
than one object is selected, the dialog
will display information about the one
object that was drawn or brought to the
front most recently.
Depending on the object type, the dialog displays the following information:
Type: This item defines the selected object
(line, rectangle, bitmap) and indicates whether
it has been rotated.
Description: This item lets you type in your
own description of the object. For example, you
may want to describe a rectangle as “Kitchen
table” or a line as “Balcony”.
Length: Vertical measurement of the object,
shown in working unit of measurement.
Width: Horizontal measurement of the object,
shown in working unit of measurement.
Area: This is the actual area of the object,
shown in working unit of measurement.
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Angle: Inclination of object in degrees; applies
to lines, constrained lines, walls drawn using
the wall tool, and hollow lines.
Layer: Indicates the layer in which the object
resides.

Data for Estimating
Estimating Description: This item works with
the Design Estimator program, available from
Abracadata.
If the selected object has an Estimating Item #
already included in the Design Estimator
database, don’t worry about filling in this box.
If you’re adding an object to the Design Estimator database, you can type in a description.
This description is usually more technical than
the one described in the previous dialog item.
Estimating Item: This item works with the
Design Estimator program.
Each object in the Design Estimator database
has a unique ID number. If the selected object
has an Estimating Item # already included in
the Design Estimator database, don’t worry
about filling in this box. If you’re adding an
object to the Design Estimator database, you
can type in a number here.
Unit Symbol: This item works with the Design
Estimator program. It tells the Estimator what
units (square feet, linear feet, number of pieces,
etc) to use for the of object.
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Include in Estimating: This item applies to the
Design Estimator program. When checked, the
object will be included in the file created when
you use the File menu option Export to Design
Estimator. Unchecked, the object will be excluded.
Include in Material List: When checked, the
object will be included in the Reports shopping
list. Unchecked, the object will be excluded.

Stud Info Button
If a stud-object has been selected, the object
information box will display a yellow "Stud
Info" button. When you press this button all
stud information is displayed which includes
board size, number of boards, center distance,
and total board length.

3D Object Info Button
The 3D Object Info button within the Object
Information dialog displays additional information about 3D objects. The information is
used by the 3D WalkAround viewer; it does
not affect the appearance of the object in your
2D design view.
The information in the dialog includes:
Height Off Ground: Distance from the ground
to the base of the object, shown in the working
unit of measurement. You can change the
object’s height by clicking the cursor on the box
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and typing a new height. (Note: If the 3D
WalkAround viewer is open, the height of the
object in the viewer will not change until you
click Okay on the Object Information dialog).
3D Image File Name: The 3D Image file is a 3D
object description file. You may use an .RWX
file in the DATA subdirectory. See the section
on how to "Create a 3D Object" for more information on 3D image files.
Texture File Name: Optional name of a bitmap
used to "texture" the object. Walls can have a
left and a right side texture.

Reports
This option lets you generate a list of materials,
to be printed or to be sent to the clipboard (for
formatting in your favorite word processor).
The materials list will show the name of each
object and the measurements appropriate for
that object.
All objects in the file will be included in the
report, except objects you have specifically
excluded. To include an object in the materials
list, click the right mouse button on the object
to bring up the Object Information dialog. Put
a check mark in the box (click on) next to
“Include in Material List” to include the object
in the report.
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Show Clipboard
This option lets you view, save, and delete the
contents of the clipboard. See your Windows
User’s Guide for details.
If this option does not work, you probably did
not install the clipboard viewer (clipbrd.exe)
when you installed Windows on your computer. You can install the clipboard viewer at
any time using the Windows Setup program in
your Main program group.

Stud Specifications
This item lets you adjust the settings for the
stud tool.
Tracking Option: This changes the way the
stud tool defines the area to be filled with
studs. You can draw using a flexible box (Rectangle option) or a flexible line (Polygon option).
To change the tracking option, click the diamond next to the one you want to use.
If you draw a stud object using the polygon
option and object dimensions displayed, do
not try to drag the line of the polygon off the
edge of the drawing area. Instead, scroll your
drawing so enough drawing area is available
for your object, then draw.
Spacing, On Center: This refers to the space
between studs, measured from the center of
one board to the center of the next adjacent
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board. Four of the most commonly used on
center distances are provided as dialog options.
To change the spacing for studs, click the
diamond next to one of the provided spacings,
or use the up and down arrows to specify
custom spacing.
You can use the stud tool to help you draw
decking. Just change the on center distance to
match board width.
Orientation: The top four orientations shown
are side views of the boards; the bottom four
are on-end views. To change the orientation,
click the diamond next to the one you want to
use.
Board Size: When you draw a stud object using
a side view orientation, you determine the
length of the boards by dragging a wider or
longer box. When you draw a stud object using
an on-end view orientation, the length of the
boards will be that specified under Length.
Four of the most commonly used board sizes
are provided as dialog options. To change
board size, click the diamond next to the one
you want, or use the up and down arrows to
set custom board thickness, width, and length.
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3D Menu

Start WalkAround
This option starts the Abracadata 3D
WalkAround viewer. The option is grayed if
the viewer is already running.

Update WalkAround
This option updates the view in the 3D
WalkAround viewer to reflect any changes you
have made to your drawing since the last time
the view was updated. For example, if you
have added furniture to the drawing, choosing
this option will cause the new furniture to
appear in the viewer.
This option has no effect if you have enabled
the Automatic Updates option. In that case,
updates are sent to the 3D WalkAround viewer
automatically as you modify the drawing.
There is no need to use a separate command to
update the viewer.
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This option is grayed if the 3D WalkAround
viewer is not active.

Stop WalkAround
This option terminates the Abracadata 3D
WalkAround viewer. The option is grayed if
the viewer is not running.

Automatic Update
Put a check mark on this menu option if you
want to update the 3D WalkAround window
every time you make a change to your design,
such as adding walls, moving objects, and the
like. This is the most natural way to use the 3D
viewer, but you may wish to disable it on a
slower computer, to improve the performance
of the drawing program.
If the option is not checked, you must use the
Update WalkAround menu command to
update the 3D scene after you have made
changes to your 2D design.

Smooth Update
Smooth Update adds to the Automatic Update
option by repositioning the object in the 3D
viewer while you are moving the object in the
2D layout, instead of waiting until you release
the mouse button. If you are unsure if your
computer can handle Automatic and Smooth
Update, try it and find out.
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Put a check mark on this option if you want
automatic updates to be sent to the 3D
WalkAround viewer continuously as you
move or rotate objects in your design. On a
powerful computer with good video performance, this can often give the impression of
smooth movement in the viewer, but it may
slow the performance of the drawing program.
If the option is not checked, automatic updates
will only be sent when you release the mouse
button or movement key at the end of a drag or
rotate operation.
This option has no effect unless the Automatic
Update option is also checked.

Setup WalkAround
This option opens a dialog box where you can
enter the complete path to the 3D WalkAround
program (abra3d.exe). Normally you don’t
need to do this, because the location is filled in
automatically by the setup process.

Creating Your Own 3D Image Files
3D WalkAround uses Renderware® which
creates an .RWX file format for it's 3D images.
This is an ASCII file which can be edited, but
best results come from the use of 3rd party 3D
modeling software. There are also many
excellent 3D files available as public domain, in
both 3D and DXF formats.
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In order to create your own 3D image files,
you will need one of the many third-party
3D design programs on the market. The
best choice would be Autodesk’s 3D studio,
since it has the most comprehensive file
format.
We have included file converters for both
3D Studio ® (.3DS) file formats and
AutoCad's .DXF file formats.

Instructions for converting a .3DS file:
In 3D Studio, you may set the units to be
real-world by choosing the "unit setup"
menu option, and entering: "architectural",
denominator: 2, 1 unit = 1.0 feet.
While in 3D Studio, move your object so
that the bottom-front-left corner of the
object is at the origin (0,0,0). One easy way
to do this is to turn on the construction
planes by choosing the menu DISPLAY/
CONST.../SHOW. Then in both the top
and front viewpoirts move the object to the
upper right corner. Making sure that the
lower left corner of the bounding box of the
object falls on the spot where the two black
lines cross.
In order to prevent errors and assure that
the object loads, you will want to change all
of the material on the object so that only
.BMP format texture files are being used.
The Abracadata 3D WalkAround viewer
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only supports .BMP format textures, so all 3DS
materials that use JPEG’s, GIF’s, TIF’s or any
other non-BMP graphic file format should be
converted to BMP or removed.
Once all of that is done, save the file to the
directory of your choice.
Converting 3D Studio & .DXF files:
Before proceeding, please take note that the
.DXF file format is an absolute “bare-bones”
format. All of the information contained
within a .DXF file is minimal at best, so it
doesn't make the best candidate for accurate
model creation or even accurate conversion.
With all of the inherent constraints of dealing
with such a minimal file format, a lot of experimentation will be required in order to come up
with a usable object. Add to this the hundreds
of different 3D design packages that save .DXF
files incompletely, or with different scaling
factors or rotations, and the problem increases.
But it is possible.
Depending on the 3D design program that you
are using, the object may appear differently
after being converted to a 3D WalkAroundcompatible file. But in most tested, the bottomfront-left corner of the object should be at the
origin (0,0,0) and it should be inverted (upside
down) when viewed from the front viewpoint.
The actual conversion process is as follows:
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1. In Windows 95, go to the Utility
folder and start the Renderware file
conversion program by double
clicking on the file named
RW3DCONV.EXE.
2. Choose Open from the file menu.
Select a 3DS or DXF type file. Match
the settings from Figure A on the
previous page.
Position and Size
Make sure that "Centre object" is not
checked. Choose "Scale by" 0.0999.
Hierarchy
Check the "Use prototypes"
Choose "Flat (Single clump)"
Hints
Choose "Hidden surface"
Textures
Check "Lit", "Show textures" and
"Override extension" with BMP
typed in.
Click OK
Next, SAVE the file into your DATA directory as named by 3D WalkAround (named
in the "Setup", under the Options menu in
the 2D window.
Once the file is converted:
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Once you have a 3D Walkaround-compatible
.RWX file, move that file into the DATA
subdirectory of the directory where you installed 3D Walkaround, along with any .BMP
texture files that the object needs in order to
display correctly. Then open the 3D
Walkaround program and draw a 2D top-view
representation of your object. Once that is
finished, select all of the pieces of your topview and group them together. Select that
grouped object, then click on the 3D Menu and
choose “Create 3D object”. You will be presented with a 3D Info dialog box, where you
type in the name of the .RWX file for the object
that you created in the 3D Image file box. You
may also type in an overriding texture file in
this dialog box, which will be applied to the
entire object. Once you OK this dialog, the
object is created and you should see it in the
3D viewer. If you would like to quickly access
this object in the future, consider adding it to a
library.
If all of the instructions have been followed,
and a question mark appears, that means that
something went wrong. Things to check include:
—Verify that all of the textures on the object
are in .BMP format only.
—Verify that the object’s .RWX file is in the
3DWALK/DATA directory.
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If the object appears, but isn’t the right scale
with all of the rest of the objects, you will need
to go back to your 3D design program and
change the size of the object accordingly and
reconvert it. The same is true if the object
shows up too dark — lighten the textures in
your 3D design program then reconvert the
object.
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3D WalkAround View
Design Your Own Home: 3D WalkAround is not
a single application but a pair of applications
that are used together; Design Your Own
Home and 3D WalkAround. Design Your
Own Home is the main application. With it,
you draw the walls of your floorplan, then you
can add symbols to represent doors, windows,
cabinets, furniture, and so on. To help you to
visualize your home design, 3D WalkAround
generates a three-dimensional view of its
interior. When you select Start WalkAround
from the 3D pull-down menu the 3D View
becomes the active viewing window. Use your
mouse to move through your floorplan.
The 3D WalkAround View offers two viewing
modes: Birds-Eye View and WalkAround
View. To toggle between the two, the following keystrokes are available:
Home — Switch to walk-around mode,
eye height, looking forward.
End — Switch to birds-eye mode, above
current position, looking down.
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Function Keys
The following function keys will help you
to navigate in 3D View. These keys are
very helpful to use if you cannot figure out
where you are in your layout. Note: F4
switches you to birds-eye mode, F5-F8
switch you to WalkAround mode.

F4 — Bird's-Eye view
The F4 key instantly jumps you to BirdsEye View mode positioned above your
layout looking down.

F5 — Front
The F5 key instantly jumps you to
WalkAround Mode and positions you at
the front of your layout.

F6 — Left Side
The F6 key instantly jumps you to
WalkAround Mode and positions you at
the left side of your layout.

F7 — Back
The F7 key instantly jumps you to
WalkAround Mode and positions you at
the back of your layout.
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F8 — Right Side
The F8 key instantly jumps you to
WalkAround Mode and positions you at the
right side of your layout.

Open
Use this command to select the Design Your
Own Home drawing you want to view in the
3D Walkaround viewer.
This command is only present on the File
Menu if you are running the 3D WalkAround
viewer in stand-alone mode. If you started the
viewer from the 3D Menu in Design Your Own
Home, use the File Open menu command in
that program instead.
Keyboard Shortcut - Ctrl+O

Wireframe
This option allows you to view the 3D window
without any texture or shading. This will
greatly speed up the movement in the 3D
window.
Wireframe Mode:
On—Textures and shading do not
appear. (faster)
Off—Textures and shading appear
normally. (slower)
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Textures
This option allows you to turn off textures
on the walls and floor. Note that all furniture objects still display their textures. This
option is most useful when the focus is on
alignment of the walls.
Texture Mode (Ctrl+T):
On — Textures (fabrics, wallpaper,
wood-grain, etc.) appear on surfaces
(slower).
Off — Textures do not appear
(faster).

Faster but Coarser
This option allows you to choose between
quality and speed. When "Faster by
Coarser" is checked, the 3D viewer drops
into a lower resolution display method, but
speed increases dramatically.
Faster Mode (Ctrl+F):
On — Scenes are drawn coarsely
(faster).
Off — Scenes are drawn with finer
detail (slower).
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Lighting Control
A special lighting feature is available in 3D
WalkAround. The first time you use this
program the default is to have the lighting
turned off. Turn on the lighting by either
pressing Ctrl+L or by clicking on the lighting
mode feature in the options menu. When a
check mark appears to the left of the lighting
mode the feature is turned on. When this
feature is on you will see that surfaces are
shaded more realistically. When this feature is
off each surface has a single lighting level. You
can brighten the lighting level by pressing F2.
Continue to press F2 until you get to the
brightness level that you like best. To darken
the lighting press F3. This will dim the lighting. Again, continue to press F3 until the
lighting is just how you like it.

WalkAround View
In this view, you walk through the floor plan
as if you were walking through a real house.
When starting WalkAround mode, you will be
placed in the bottom center facing toward the
house.
As with the Birds-Eye View, to move through
the house with your mouse: Consider the
mouse to be a virtual joystick. Center the
mouse in the WalkAround window. Press and
hold down the left mouse button. Moving the
mouse forward and backward will walk the 3D
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viewer forward and backward respectively.
Moving the mouse side to side causes the 3D
viewer to rotate in that direction.
For more precise control of your movements
through the house use the arrow keys on your
keyboard. While in the WalkAround View the
following keyboard controls are available.
Up/Down Arrow — move forward,
back.
Ctrl + Up/Down Arrow — tilt up or
down.
Page Up / Page Down — raise or lower
eye level.
Left/Right Arrow — turn left or right.
Shift + Left/Right Arrow — slide left or
right.
Escape — stop movement.

Birds-Eye View
When you first start 3D WalkAround, the
default mode is Birds-Eye View. This mode
provides an aerial view to inspect the house
and view the floor plan from any angle. To
move around while in the Birds-Eye View
consider the mouse to be a virtual joystick.
Center the mouse in the WalkAround window.
Press and hold down the left mouse button.
Moving the mouse forward and backward will
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walk the 3D viewer forward and backward
respectively. Moving the mouse side to side
causes the 3D viewer to move in that direction.
For more precise control use the arrow keys on
your keyboard. While in the Birds-Eye View
the following keyboard controls are available:
Up/Down Arrow — move to top or
bottom of layout.
Left/Right Arrow — move to left or
right side of floorplan.
Shift + Left/Right Arrow — rotate
layout left or right.
Page Up / Page Down — zoom out/
zoom in.

Setup
This option lets you set the path to your image
files. Normally the path is set when you first
install the program, and you don't need to
change it.

Printing a 3D View
Set the 3D View window so it displays the
view you want to print. Use Ctrl+C or Edit |
Copy to copy the view to the clipboard. Paste
the image into a new Architecture drawing,
stretch it to the size you want, and choose File
| Print.
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Or you can paste the image into Paintbrush or
your favorite picture editing program for
touch-up and printing.

Exit
Closes the file you have been viewing and
closes the 3D WalkAround viewer.
Keyboard Shortcut - Alt+F4
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Interfacing with Design Estimator
It’s easy. Just select the “Export To Design
Estimator” option in the File menu. The program will make a file with your current file
name and the extension CSV. That file will be
placed in the working directory. When you use
Design Estimator access the file in the same
directory where you saved your plan.

Importing Files
Importing files from the DOS version of Design
Your Own Home. Each program (3D
WalkAround, Architecture, Interiors, and
Landscape) can import files from any of
Abracadata’s DOS Design Your Own Home
programs. To import a file, simply select Open,
select the drive and directory where you Abracadata Design Your Own Home DOS files are,
and then choose All file in the List Files of
Type box. Select your DOS file, click okay and
it will import into the Windows program.
Note: Before opening the DOS file, be sure the
current font and style is what you want for
your plan. The import function uses the current font for all text that is imported.
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Working with Layers
1. Objects on more than one layer. If you draw
an object on two layers, the object will act as if
it’s only on one, even though you see it in two
layers. So if you change it on one layer, even if
the other layer is inactive, it will still change on
the second layer. If you delete it from one
layer, it will be deleted from the other layer
also.
2. Deleting layers. You can delete a layer or an
object, but you get a different result for each. If
you delete a layer, its objects will reside on the
base, they won’t go away. If you want to get
rid of all the objects on a layer, delete them just
like any other object, then delete the layer.
On the base layer of your drawing, the appropriate layer where the object originally was
drawn will also change. This will be helpful for
vertically lining up load-bearing walls, for
example. Just set them on top of each other in
the base layer, and the separate layers will also
be set correctly.
4. Tricks with "Show outline when inactive".
If you are creating a multi-story house, and
you want to add electrical and plumbing to
each floor as a separate layer, be sure to utilize
the “Show Outline when Inactive” option
available in the layer dialog. To get back to an
existing layer dialog to change the option, just
double-click the layer number in the layer bar.
143

By turning the “show outline...” option on and
off as you need it, you can set up items that
relate only to one other particular layer, no
matter which one it is. For example, you could
turn off every outline except for the second
layer. Then you could set up the second layer
plumbing on the fifth layer while looking only
at the second layer’s outline. Then turn the
second layer outline off, turn only the third
layer outline on and use the sixth layer for the
third layer’s plumbing.
5. The Default/Base Layer. If you import files
from DOS Design Your Own Home or if you
start a new drawing in 3D WalkAround, your
drawing will default to start on the base layer.
Objects that are on the base layer cannot be
seen on any other layer. Therefore, if you need
to view objects on one layer while working on
another, first click the plus (+) sign to create a
new layer. (And be sure to check the “Show
Layer When Inactive” box.) Next return to the
base layer and use Ctrl-A to select all the objects on that layer, choose Cut from the Edit
menu (Shift-Del) change to layer one (or another layer) and then select Paste from the Edit
menu (Shift-Insert). All your base-layer objects
will be moved to the new layer. Then you can
add other layers and still see the objects on the
layer you just created.
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Dimension Lines
This is the line at the very bottom of the line
palette with an X in its center. The dimension
line will automatically indicate its length as
you stretch it. The dimension line will also take
on the line-end characteristics that you have
selected for the Line Palette.
You can change the size, font, and style of the
characters in the dimension line just like you
do with any text. Just select the line and go to
the text menu to change the characteristics.
To display an automatic dimension line next to
a wall object, select the wall, then hold down
Ctrl and click the Measuring Tool icon. To hide
the dimension line, repeat the procedure.
To change the length of a dimension line, or
wall object with dimension line attached to it,
click the text tool icon, then click the numbers
on the dimension line. Type a new length in
the working unit of measurement: English or
metric (e.g., 8 ft 3 in, 8.5 ft, 7.5 cm).

Nudging Objects
You can use your mouse and the various tools
to draw, move, and resize objects. If you need
more precise drawing or placement, however,
you can use the keyboard in combination with
your mouse and the tools. The instructions
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below are for moving an object, but you can
use the same technique to draw and resize
objects, too.
To nudge an object: Select the object you want
to move, then hold down the left mouse button
and use the arrow keys on the keyboard.

Calculating Square Footage
It is easy to have Design Your Own Home: 3D
WalkAround quickly calculate the square
footage of an area for you. You simply select
the polygon tool and draw a shape to match
the area you want to have calculated. Then
right click your mouse button while the polygon is selected and it will give you the object
information dialog box. One of the pieces of
information displayed is the total square footage of the area.

Drawing a Deck
You can use the Stud tool to help you draw
decking. Choose Stud Specifications from the
Options menu, then change the on center
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distance to match board width. The following
illustration shows a deck drawn using the Stud
and Hollow-line Tools.
This deck was drawn with a 2' x 4' board size
and the on center distance adjusted to match
board width (in this case, 4"). A hollow line
was then drawn along each edge of the stud
object, giving the deck a finished look.

Stud Tool
This tool draws a stud object, showing joists or
studs, whose size and orientation are determined by the settings in the Stud Specifications
dialog.
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Tracking Option: This changes the way the
stud tool defines the area to be filled with
studs. You can draw using a flexible box (Rectangle option) or a flexible line (Polygon option). To change the tracking option, click the
diamond next to the one you want to use.
If you draw a deck using the polygon option
with object dimensions displayed, do not try to
drag the line of the polygon off the edge of the
drawing area. Instead, scroll your drawing so
enough drawing area is available for your
object, then draw.
Spacing, On Center: This refers to the space
between studs, measured from the center of
one board to the center of the next adjacent
board. Four of the most commonly used on
center distances are provided as dialog options. To change the spacing for studs, click the
diamond next to one of the provided spacings,
or use the up and down arrows to specify
custom spacing.
Orientation: The top four orientations shown
are side views of the boards; the bottom four
are on-end views. To change the orientation,
click the diamond next to the one you want to
use.
Board Size: When you draw a stud object
using a side view orientation, you determine
the length of the boards by dragging a wider or
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longer box. When you draw a stud object using
an on-end view orientation, the length of the
boards will be that specified under Length.
Four of the most commonly used board sizes
are provided as dialog options. To change
board size, click the diamond next to the one
you want, or use the up and down arrows to
set custom board thickness, width, and length.
To draw studs: Adjust the settings in the Stud
Specifications dialog to what you want. Be sure
to specify which tracking option you want:
rectangle or polygon. This changes the way the
stud tool defines the area to be filled with
studs. You can draw using a flexible box (Rectangle option) or a flexible line (Polygon option). The polygon option is slower to redraw,
so you should complete the rest of your drawing before drawing a polygon stud object.
Select a line color. Set line thickness or style by
clicking the appropriate icon on the line palette, then click the stud icon on the tool palette.
Move the cross hairs to where you want to
begin drawing. Press and hold the left mouse
button to anchor one corner of a flexible box
(or flexible line, if using polygon tracking
option). Drag the cross hairs. The flexible box
(or line) stretches from the anchor point tot he
mouse position. Notice that if you drag it off
the side or bottom of the screen automatically
scrolls to accommodate the size you want.
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When the stud box (or polygon) is the size and
shape you want, release the mouse button (or
click the right mouse button to complete the
polygon).
To draw a perfectly square box, or to constrain
the lines of the polygon, press the Ctrl key
while you drag.
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Keyboard Use
Although we highly recommend a mouse for
using 3D Walkaround, sometimes might not be
convenient. So here are the instructions for
using the program with your keyboard keys.
To move the pointer: Use the arrow keys, or
the number pad with Num Lock off. The
pointer picks up speed the longer a key is held
down.
To access a menu: Press the Alt key, use the
right and left arrow keys to highlight the menu
you want (or press the first letter of the menu's
name), then press Enter or a down arrow to
open the menu. Once one menu is open, arrow
right and left to see all menus in their open
position convenient if you're looking for a
particular option.
Once you have the proper pull-down, use the
arrow keys to highlight the option you want,
Then press Enter. Or press the underlined
letter of a menu item (no Enter is necessary).
Press Esc to cancel the menu, and press Alt to
leave the menu bar.
Keyboard shortcuts are available for many
commands. These are listed to the right of
commands in a menu and in Chapter 4 and are
certainly most handy if you don't have a
mouse.
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In The Drawing Window
To draw with a tool (except the polygon tool):
Select the tool you want to use, then position
the cross hair where you want the object to
start by pressing arrow keys. Hold down the
Shift key and use the arrows to stretch the
object to size. When the object is the size and
shape you want, release the Shift key.
To draw with the polygon tool: Select the
polygon tool, then position the cross hairs on
the drawing. Hold down the Shift key, use the
arrow keys to drag the first line segment, then
release the Shift key. When you have stretched
the segment to the length you want, press
Enter. Use the arrow keys to drag the second
segment to size, then press Enter. Add other
segments in the same way. After you’ve drawn
the last segment, press Esc to complete the
polygon.
To select an object: First select the selector
tool. Position it over the object you want to
select and press Enter. Four black handles will
appear around the object, indicating selection.
To select an additional object: Position the
selector tool over another object, hold down
the Shift key and press Enter.
To select objects by using a selection box:
Position the selector on a blank area of the
drawing. Hold down the Shift key, then use
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the arrow keys to drag a box around the
object(s) you want to select. Any object completely enclosed by the box will be selected.
To select all objects: Choose Select All from
the Edit menu, or use the keyboard shortcut
Ctrl + A.
To unselect an object: Position the selector
over the object you want to unselect, hold
down the Shift key and press Enter. The
handles will disappear.
To unselect all objects: Position the selector on
a blank area of the drawing and press Enter.
To move objects: Select the object(s) you want
to move, then position the selector over the
object, hold down the Shift key, then use the
arrow keys to drag the object to where you
want it.
To resize an object: Select the object you want
to resize. Position the selector over one of the
object’s handles, hold down the Shift key, then
use the arrow keys to drag the handle until the
object is the size and shape you want. When
you’re done, release the Shift key.
To select a fill pattern or color: Tab to the
pattern palette. Use the arrows keys to point to
the pattern you want, then press Enter.
To select a line pattern: Tab to the pattern
palette. Use the arrow keys to point to the
pattern you want, then hold down the Shift
key and press Enter.
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To change the pattern fill color: Tab to the
color palette, arrow to the color you want the
pattern background to be and Press Ctrl +
Enter.
To change the pattern line color: Tab to the
color palette, arrow to the color you want the
foreground to be and Press Ctrl + Shift + Enter.
To type text: Select the text tool, then position
the cursor on the drawing where you want the
text to start. Press Enter to begin entering text,
then press Esc when you’re done.
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